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1 Introduction

1.1 KnowledgeWorks

KnowledgeWorks”® is a LispWorks” toolkit for building knowledge based systems. It is a multi-paradigm programming
environment which allows developers to express problems in terms of objects, rules, and procedures. This section provides
an historical perspective and an overview of the system.

1.1.1 Background

Broadly speaking, there have been two generations of commercial knowledge based system (KBS) shells. The first
generation of KBS shells were built on top of symbolic programming languages such as Lisp. These shells exhibited a high
degree of flexibility and functionality as aresult, but suffered because of their lack of standardization, poor performance, and
inability to communicate with other applications. The second generation of KBS shells were generally written in C to attack
the latter two weaknesses of Lisp-based shells. However these C-based shells are inevitably less flexible, and exacerbate the
standardization issue. Although written in a C (a standard language), each C-based shell must re-invent arange of features
aready provided as standard in every Common Lisp implementation, including the object-system and even elementary
structureslike lists.

KnowledgeWorks addresses all of these issues by providing a high performance rule-based system for LispWorks. The latter
isafull and efficient Common Lisp implementation including the Common Lisp Object System (CLOS), and foreign
function interfaces to languages such as C, C++, and FORTRAN. Hence KnowledgeWorks constitutes atightly integrated
multi-paradigm programming environment, allowing all the most powerful features of rule-based, object-oriented and
procedural approaches to be combined without abandoning accepted standards.

1.1.2 Technical Overview
KnowledgeWorks includes:

* High performance inferencing mechanisms:
forward chaining (OPS compatible).
backward chaining (Prolog compatible).

A powerful standard object system (CLOS).

A flexible standard procedural language (Common Lisp).
» Metaprotocols for extending the object and rule systems (MOP & MRP — see below).

 Support for multiple independent inferencing operations using inferencing state abjects.

A full set of graphical toolsfor developing and debugging knowledge bases.

Built using the CAPI and integrated with the LispWorks IDE.

I ntegration within larger applications, possibly following a completely different paradigm.



1 Introduction

The parts of KnowledgeWorks
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KnowledgeWorks rules perform pattern-matching directly over the object base (KnowledgeWorks CL OS objects and
KnowledgeWorks structures). Forward chaining rules use this pattern-matching to perform actions, while backward chaining
rules use it to deduce goals. The actions of forward chaining rules can call backward chaining rules, and the backward
chaining inference engine may also invoke the forward chainer. Forward chaining rules may be grouped to increase the
modularity of the rulebase and to introduce a mechanism for procedural control by explicit invocation of rule groups.

KnowledgeWorks CL OS objects are conventional CL OS objects with the simple addition of amixin class providing
KnowledgeWorks functionality, and they can be used outside the rulebase as ordinary CLOS objects. Any existing CLOS
code may simply be reused and augmented with rules by adding the mixin to chosen classes.

LispWorks CLOS includes an implementation of the Meta Object Protocol (MOP) which allows the object system to be
extended and customized in a standard way. In the same spirit of self-reflection, KnowledgeWorks rule-based system can be
extended and customized using a Meta Rule Protocol (MRP) which allows meta-interpreters to be defined for rules. Together
these protocols mean that KnowledgeWorks defines a region rather than a point in space of KBS shells, and ensure that
developers are not constrained by the default behavior of the system.

KnowledgeWorks has a comprehensive programming environment that enables rapid development and debugging of
rulebases. Tools are provided that enable the interactive examination of classes and objects. Graphica debugging windows
alow forward and backward chaining rules to be single-stepped and monitored. The full LispWorks programming
environment and tools are also available, for example, the editor which allows rules to be defined and redefined incrementally
and dynamically (see the Editor User Guide). You can include KnowledgeWorks in a delivered runtime application if you
have LispWorks Enterprise Edition, LispWorks for iOS Runtime or LispWorks for Android Runtime. See the Delivery User
Guide for details.
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1.2 Notation and conventions

1.2.1 Prolog syntax
Syntax will be presented in BNF. Any other non-standard notation will be explained as used.

D= introduces a definition.

<..> token, or non-terminal symbol.

[..] delimits optional items.

* 0 or more repetitions of the previous token.
+ 1 or more repetitions of the previous token.
| separates alternatives.

1.2.2 Viewing example files

This manual sometimes refers to example filesin the LispWorks library viaaLisp form like this:

(example-edit-file "kw ani mal / def syst ent)

These examples are Lisp source filesin your LispWorks installation under | i b/ 8- 0- 0- 0/ exanpl es/ . You can simply
evaluate the given form to view the example sourcefile.

The examplesfiles are in aread-only directory and therefore you should compile them inside the IDE (by the Editor
command Compile Buffer or the toolbar button or by choosing Buffer > Compile from the context menu), so it does not try
towrite afad file.

If you want to manipulate an example file or compile it on the disk rather than in the IDE, then you need first to copy thefile
elsawhere (most easily by using the Editor command Write File or by choosing File > Save As from the context menu).

1.2.3 Appearance of the graphical tools

Please note that your windows may differ in some respects from the illustrations given in this manual. Thisis because some
details are controlled by the window manager that you are using, not by LispWorks itself.

The screenshots in this manual show toolbars that may have been customized (using the context menu) so you might see
some differences from your setup.

10



2 Tutorial

The tutorial isasimple example based on an animal guessing game. In this game the user thinks of an animal and the
program asks yes/no questions. Eventually the program mentions an explicit animal and asks whether it is correct. If so, the
game ends. If it isnot correct it will ask what the animal was and ask for a question to distinguish it from its last guess. This
isatrivial example of alearning program. The tutorial assumes a certain familiarity with Lisp, LispWorks and the Common
Lisp Object System (CLOS).

All examplesin this chapter assume that you are typing in expressions in a package that uses the KwWpackage, for instance,
KW USER.

2.1 Getting Started
To run the tutorial, put thisformin your LispWorks initialization file (usualy called . | i spwor ks):

(require "kw")

Start LispWorks. The KnowledgeWorks Podium window will appear. Note the position of the KnowledgeWorks menu,
which you will use to access the tools described in this manual .

KnowledgeWorks Podium

% LispWorks 6.0.0 -
File Edit Tools EnowledgeWworks ‘Warks D Hiskory Windows Help

Ded: 2R  %RRrL BHF

E:.;,[-j[c-:]&'i:dﬁD“EE@@@@E:Lr%'

Active Window : Liskener 1

On Microsoft Windows you may see a different Podium, depending on which of the Window Options has been selected. See
the section "Windows Multiple Document Interface” in the LispWorks IDE User Guide for details. This manual, the
KnowledgeWbrks and Prolog User Guide, will usually show single windows in figuresin order to show more detail for the
specific KnowledgeWorks tool under discussion.

2.2 Loading the Tutorial

11



2 Tutorial

KnowledgeWorks Listener

% Knowledgeworks Listener 1

First bring up a KnowledgeWorks Listener by choosing KnowledgeWorks > Listener from the KnowledgeWorks Podium.
The KnowledgeWorks Listener accepts Lisp input aswell as KnowledgeWorks input. Enter:

(i n-package "KW USER")
into the KnowledgeWorks Listener, and then change the current directory to that of the animals demo by entering:
(cd (lispworks:example-file "kw aninmal/"))
If thisfails, check the value of the Lisp variable*1 i spwor ks- di rect ory*.
Load the tutorial by typing:
(1l oad "defsystent)
to load the tutorial system definition, and:
(conpil e-system "ANIMAL" :load t :target-directory (get-tenmp-file))

to compile and load the rules and object base (CLOS objects). Ininterpreting these two commands, the KnowledgeWorks

Listener has behaved just like aLisp Listener. In general, whenever input has no specific KnowledgeWorks interpretation, the

KnowledgeWorks Listener just acceptsit as Lisp.

2.3 Running the Tutorial

First run the tutorial example afew times. Think of an animal and type (i nf er) into thelistener. i nf er isafunction which
starts the forward chaining engine. Popup question windows will appear, which require clicking on either Yes or No. If your
animal is guessed correctly, execution will terminate and the listener prompt will reappear. If the final guessis incorrect then:

1. Another popup will ask what the animal was. Type in the name of an animal and press Ret ur n (or click on OK). If the
animal is already known to the system this constitutes an error. A confirmer popup will inform you of this; click on
Confirm and execution will terminate.

2. You will be asked for a question to distinguish your animal from the system's last guess. Typein aquestion (again
without quotes or double-quotes) and press Ret ur n. Execution will terminate.

12



2 Tutorial

3. Thetutorial may be restarted by typing (i nf er) againin thelistener. Thistime the system will know about your new
animal and the question that distinguishesit. Every time the rule interpreter finishes, it will return and display in the
listener the number of rules the forward chaining engine fired.

2.4 Browsers

There are anumber of browsers for examining the state of KnowledgeWorks. They will be introduced here, and again when
the Programming Environment is discussed in 5 The Programming Environment.

2.4.1 Rule Browser

K nowledgeWorks Rule Browser

“% Rule Browser 1 g@]g|

Contexts | KwW:DEFAULT-COMTEXT

Filter - M Matchez 5

Ew-USER:ANIMAL-GUESTION
Ew-LUSER::GAME-FIMISHED
Edd-USER:NEW-LUESTION
o -LISER
Ew-USER:Y-N-UQUESTION

|Heady.

This may be obtained by choosing KnowledgeWorks > Rules. The defined forward chaining contexts (or rule groups) are
displayed in adrop-down list at the top. Thereisaso a special pseudo-context for all the backward chaining rules, which is
shown initially. In this case, the only other context is named DEFAULT- CONTEXT. Below that are listed the rules for the
selected context. Choose DEFAULT- CONTEXT from the drop-down list and click on one of the rules, for example PLAY, and
edit it by choosing Works > Rule > Find Source from the menu bar. An editor window will appear showing thisrule
definition.

What thisrule saysis.

(root ?r node ?node)

(not (current-node ? node ?))

-->

((capi:display-nmessage " AN MAL GUESSI NG GAME - ~
think of an animal to continue"))

(assert (current-node ? node ?node))

which means:

If the node ?node isthe root node of the tree of questions, and there is no current node indicating the question about to be
asked, then tell the user to think of an animal and make the root node ?node the current node (so that the top question of the
tree will be asked next). Thisisthe rulethat starts the game by instructing: "if you haven't got a question you're about to ask,
ask the topmost question in the tree of questions'. The detailed syntax of forward chaining rule definitions will be explained
in 3.1 Forward chaining.

Select"-- Al backward rul es --"fromthe drop-down list and bring up a backward chaining rule definition by
clicking on its name in the Rule Browser and choosing Works > Rule > Find Source again. The detailed syntax of backward

13



2 Tutorial

chaining rulesisin 3.2 Backward Chaining.

2.4.2 Objects Browser
K nowledgeWorks Objects Browser

% Dbjects Browser 1

. &
Current cocle number: [ B Shiow Inferencing State: | :DEFALLT

Preset quer/pattern: | Custom w

[NODE “7object]

[NODE #<MODE 20714347)
MODE #<MODE 2071430F
(MODE #<MODE 222C7483F ]
[MODE #$<MNODE 22207477
[NODE #<NODE 222C7AAF ]
[NODE #<MODE 222C7AE )
[NODE #<MODE 222C7B1F>)

IMOME HebOnE 222 7RET-

CLOS object: Existed at ztart
Slats:

AMIMAL : HIL

GQUESTION : "Does it have stripesy"’
YES-MODE : #<MODE 222C7B1F >
MO-MODE : #<MODE 222C7A77

|Heady.

The Objects Browser isfor exploring the contents of the KnowledgeWorks object base. Start it by choosing
KnowledgeWorks > Objects. The system knows about the CLOS objects that make up the object base. One class of CLOS
objectsin this exampleisthe node class so choose NODE from the Preset query/pattern drop-down. All the node objectsin
the object base will be displayed in the pane below. Click on one of these objects and the bottom pane will display the slots
and dot values of the object.

To make the display clearer and allow input without explicit package qualifiers, change the package of the Objects Browser.
Do thisviaTools > Preferences... > Objects Browser > Package. Edit the Package pane so that it says KW USER and press
OK.

Now change the Query fieldtoread (node ?obj ect ani mal ?a) and pressRet ur n. The animals associated with each
node are displayed. In this gamethereisatree of questions with each node object representing a question. Some nodes have
ani | valuefor theanimal dot; these are the non-terminal nodes in the question tree. The program learns your new animals
by adding new nodesto the tree.

Now type ?a into the Pattern field (and press Ret ur n). Thisdisplays only the animals. The values displayed in the topmost
of the two panesisthe Pattern field instantiated with every possible object that matches the Query field. However, if the
Pattern field is empty then the value of the Query field istaken to be the pattern.

Changethe Query fieldtoread (and (node ?n ani mal ?a) (test ?a)) andpressRet urn.

14



2 Tutorial

Objects Browser matching animals

' Objects Browser 1

H‘:v

Current cocle number: [ B Shiow Inferencing State: | :DEFALLT

Preset quer/pattern: | Custom w

[and [hode ?n animal ?a) [test al)

Mo further infarmation available

Only the non-nil animals are displayed.

2.4.3 Class Browser

15



2 Tutorial

KnowledgeWorks Class Browser

% Class Browser 1 EHE”E
o=

|Kw-USER:NODE v X3

Hierarchy | Superclaszes Sul:u:lasses| Slots |Initarg3 Funchions | Precedence
Include Inhented Slots

Filter - M Matches B

EhALPHA-SLOT-TABLE
Ea-USER:ANIMAL
EWw-LUSER:NO-MODE
Er-USER:LUESTION
EWwRECEMNCY

ki -USER:YES-NODE

Drezchption:

From Claszes: Kw-USER::NODE
Slat Mame: Fw-USER:ANIMAL
Type: T
Iritargs: AMNIMAL
[rutfarm: MIL
Readers: Fhw/-USER:NODE-aM[MAL
Wwhiters: [SETF K:W-USER:MODE-AMIMAL)
Allocation: [ INSTAMCE

The Class Browser is obtained by choosing KnowledgeWorks > Classes. This brings up the LispWorks Class Browser with
an initial focus on the class st andar d- kb- obj ect . Select the Subclasses tab to display the subclasses of

st andar d- kb- obj ect . Double click on NODE in the subclasses pane to examine the node class used in this tutorial. Select
the Slots tab to display its slots and click on one of the slots in the middle pane, for example the ANl MAL slot. This displays
more information about the slot in the Description pane.

Other useful features of the Class Browser include the Superclasses tab which display a graph of the superclasses; the
Hierarchy tab which displays direct superclasses and subclasses; and the Functions tab which displays the generic functions
or methods defined on a class either directly or through inheritance. For more information about the Class Browser, see the
LispWorks IDE User Guide.

2.4.4 Forward Chaining History

16



2 Tutorial

KnowledgeWorks Forward Chaining History

“#% F C History 1
Current cycle number: [ & Show Inferencing State: | -DEFALILT

Contexts FC Cycles

1 DEFAULT-COMTEXT 1 2 3 4 b B
PLAY n mfw
-M-QUESTION BN
AMIMAL-LUESTION

MEW-LWUESTION

GAME-FIMISHED

|Heady.

DEFAULT-COMTEXT

Thisis obtained by choosing KnowledgeWorks > FC History. If you have just run the tutorial a window will appear of which
the left column contains the entry DEFAULT- CONTEXT. These are all the contexts (rule groups) the forward chaining engine
has executed (in this case only one). On theright is a detailed breakdown of what happened in each cycle within this context.
You will see the rule names listed down the left, and the cycle numbers along the top. The boxes indicate which rulesfired.
In the last cycle, you will see ablack box indicating that the rule GAMVE- FI NI SHED fired, and a outlined box for the rule
PLAY. This means that the rule PLAY could have fired, but that GAME- FI NI SHED was preferred.

Note: you can remove the package prefixes from displayed symbols by setting the current package of the FC History tool to
KW USER, in the same way as you did for the Objects Browser tool (see 2.4.2 Objects Browser).

L ook at the definition for GAME- FI NI SHED (find the source using the Rule Browser) and notice that it contains
cpriority 15. Thismeansthat the GAMVE- FI NI SHED rule has higher priority than the PLAY rule (which has the default
value of 10), and so was preferred. Other methods of conflict resolution are also available.

2.5 KnowledgeWorks Listener

The KnowledgeWorks Listener has already been shown to function as aLisp Listener. However it extends this with the
ability of the Objects Browser to match objects. When using the Objects Browser the Query pane contained patterns which
could be matched against the Object Base. These same patterns can be entered into the KnowledgeWorks Listener. Enter
(node ?o0bj ect) intothe Listener. Thisasks"Are there any node objects?'. A NODE object will be returned. To ask for
more solutions press the Next button. If there are more you will be shown another, otherwise the listener displays the word
NO and the listener prompt reappears. If you do not want to see any more, just press the Ret ur n key.

Try entering some of the other expressions from the Objects Browser, for example
(and (node ?n animal ?a) (test ?a)). If theinputisnot recognized it istreated as Lisp.

2.6 Debugging

17



2 Tutorial

2.6.1 Monitoring Forward Chaining Rules
KnowledgeWorks Rule Monitor

% Rule Monitor 1 - KW-USER::PLAY

Select instanhations

(3 All Unfired Instantiations Show Inferencing State: | -DEFALLT
(*) Matching Selected Conditions

(Kx-JSER:ROOT kM-USER: 7R EM-USER::HODE E\W/-USER:"MODE]

(MOT [EM-USER:CURRENT-HMODE COMMOMN-PROLOG:? KMW-USER::MODE COMMON-PROLOG: 7]

Murmber af instantiations matching selected conditions: 1

[nztantiation 1;
YR = #<kW-USER:ROQT 222C7IE T

YNODE = #<kWwW-USER:NODE 222C743F:
=70

One of the problems with forward chaining rules is determining why they are (or are not) being matched. To deal with this
KnowledgeWorks has Monitor Windows for forward chaining rules. To bring up a Monitor Window, select the

DEFAULT- CONTEXT in the Rule Browser, click on PLAY and choose Works > Rule > Monitor. Alternatively you can use the
context menu to raise the Rule Monitor window. A Rule Monitor window appears displaying in its upper pane the conditions
of therule. Both are highlighted meaning they are matched (as single conditions without reference to any variable bindings
across conditions) in the object base. If you select one or more of these conditions, the message will change from "Number of
instantiations matching selected conditions: <n>" to "No instantiations matching selected conditions' depending on whether
objects can be found in the object base to match all the selected conditions at once (this takes account of variables bound
across conditions).

By selecting the All Unfired Instantiations button, you can list any unfired instantiations of the rule. In this case there is one
unfired instantiation. Selecting thisin the lower pane and then choosing Works > Instantiations > Inspect raises an Inspector
tool displaying the variable bindings in the instantiation.

You can have any number of monitor windows (though at most one per rule). At times (during rule execution, for example)
the object base may change. Monitor windows can be updated by choosing Tools > Refresh from the Rule Monitor menu bar,
or KnowledgeWorks > Memory > Update Monitor Windows from the KnowledgeWorks Listener. When you are single-
stepping through rules (see below) Monitor windows are updated automatically.

2.6.2 Single-Stepping Rules

18



2 Tutorial

KnowledgeWorks Gspy Window

% Rule Gspy 1 - KW-USER:: Y -N-QUESTION/4

[[CAPLCOMFIRM-YES-0OR-NO 0] PANSWER]
[COMMOMN-PROLOGERASE YCURREMT]
[[EW-USER:FIND-NEW-MODE YANSWER ... YMEW-CURRENT]
ASSERT [KW-USER::CURRENT-NODE Y1173 ..]]

(R -USER:Y-N-LQUESTION 70 . ]e

Select arule, say, Y- N- QUESTI ON, in the Rule Browser and choose Works > Rule > GSpy from the menu bar. This brings up
a Spy Window for the rule. In it you will see the actions of therule.

Now enter (i nf er) inthe Listener to run the demo again. Execution will stop when thisrulefires. A messagein the listener
will say that the rule Y- N- QUESTI ON has been called. Click on the Creep button at the bottom of the Listener to single step
through the rule. Watch the highlight move through the Spy Window as you go. If you still have a Monitor Window for the
PLAY ruleit will be updated automatically as you go.

Click on Leap at the bottom of the Listener and it will "leap" to the end of the rule. When you have finished, close the Spy
Window (for example by pressing Al t +F4) and press Leap in the Listener window to remove the break point and continue
normally.

At any point when rule execution is suspended by this mechanism, the other KnowledgeWorks tools may be used, for
example to examine the object base (with the Objects Browser) or see which rules have fired (with the forward chaining
history). Spy Windows are available for backward chaining rules as well, and they work in exactly the same way (they are set
by selecting the rule in the Rule Browser and choosing Works > Rule > Gspy).

2.6.3 Editing Rule Definitions
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2 Tutorial

KnowledgeWorks Editor

‘ Editor 1 - animal-rules. lisp
= - - @ oo Iy %
Tent | Cutprat || Buffers || D efinitions || Changed Definitions || Find Definitiun3|

{assert {node ?node animal nil yes-node ?yes-node no-node ?no-node
question ?question))}}

| >

[{defrule game-finished :forward
tpriority 15
(game—-ouer 7q}

-=>

(erase 7q)
: (test {not {capi:confirm-yes-or-no "Play again?"}}}
(return))

e e e e BACKWARD CHAIWIMG ----———"—"—""""""""""""""—- » ¥
CODE-PAGE - animal-ules.lizp  EKW-USERY [Lisp] B0-71 [113] C:\Program FileshLispia'ork s\iBNE-0-0-0%exarnple sk whanimalsani

L et us suppose that when the demo finishes we would like it to ask if we want to play again. Find the definition for

GAME- FI NI SHED (using the Rule Browser). One linein the definition is commented out with a; (semi-colon) at the start.
Remove the semi-colon and compile the new definition by choosing Works >Definitions > Compile from the editor menu bar.
Press Space to return to the editor view. This rule will now ask if the user wants to play again and execution will only stop
(the (r et ur n) instruction ends execution) if requested. Run the demo to see this happen.

The rule FETCH NEW ANI MAL also has a commented-out line (repeat) which will make it repeat its prompt until given an
animal it does not already know. Remove the semi-colon at the start of the line in and compile the new definition of the rule.
Run the demo again and try giving the system an animal it recognizes. It will prompt again. Giveit an animal it does not
recognize to finish.

2.7 Lisp Integration
You can save your object base of animals by entering:
(save-animal s "ny-ani nal -objs.lisp")
into the Listener. Inthefileof rules” ani mal -rul es. | i sp" look at the function save- ani nal s which doesthis. Note

how the Lisp code directly uses the same objects as the rules. If we used the Lisp code to modify the slots of the objects the
KnowledgeWorks rule interpreter would keep track.

Note: KnowledgeWorks CLOS objects are ordinary CLOS objects and can be used outside K nowledgeWorks rules.

2.7.1 The LispWorks IDE

The entire programming environment of the LispWorks IDE is available from the menus on the KnowledgeWorks Podium
window. Seethe LispWorks IDE User Guide for more details.
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2.8 Systems

KnowledgeWorks System Browser

% System Browser 1

- BB

s [AMIMAL

Tree |Te:-:t Preview | Output

= f ANIMAL
S 4 ANIMALPROG

animal-rules. lizp
=1 e ANIMAL-DATA

animal-objz. lizp

Dezcrption:

Mame: AMIMAL
Fathname: C:\Program FilezhLizptadorkz\ibhE-0-0-0hexampleshkowhanimalt
Flags:

Ready.

If you are familiar with LispWorks system definitions, look at the system definition for the animal demo, by evaluating:

(example-edit-file "kw ani mal / def syst ent)

It contains systems with type : kb- syst emand : kb-i ni t - syst em Examine the components of each system (which can be
source files or subsystems) using the System Browser which is available from the Editor viaAl t +X Descri be Systemor
File > Browse Parent System.

Systemswith type : kb- syst emare reloaded when the rules are cleared. Systems with type: kb-i ni t - syst emare reloaded
when the object baseis cleared.

Try this out by finding the KnowledgeWorks Listener and choosing Memory > Clear Objects and Rules. Then enter

(1 oad-system " ANI MAL") into the KnowledgeWorks Listener to reload the system ani nmal . Both thefiles

ani mal - rul es and ani mal - obj s arereloaded. Now choose KnowledgeWorks > Memory > Clear Objects and reload the
ani mal system again and note how only the file ani mal - obj s is reloaded.

2.9 Exiting KnowledgeWorks
KnowledgeWorks is integrated with LispWorks so you cannot exit from KnowledgeWorks independently. You can close
individual KnowledgeWorks windows. You can exit LispWorks by choosing File > Exit from the Podium. If you have any

unsaved edited files you will be asked whether you wish to save them. There will be afinal confirmation before
KnowledgeWorks quits.
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KnowledgeWorks rules are defined as follows:

<rule> ::=
(defrul e <rul e-nanme> <direction> [<doc-string>] <body>)

<direction> ::= {:forward | :backward}

Every rule must have a unigue name which must also be distinct from any KnowledgeWorks object class name and from any
context (rule-group) name. The expressions which form the body of a rule have the same syntax and meaning regardless of
whether they occur on the left or right hand side of aforward or backward chaining rule. If doc-string is given, then it should
be astring. The value can be retrieved by calling the function docunent at i on with doc-typer ul e.

3.1 Forward chaining

3.1.1 Overview

Forward chaining rules consist of a condition part and an action part. The condition part contains conditions which are
matched against the object base. If and only if all the conditions are matched, the rule may fire. If therule is selected tofire,
the actions it performs are given in the action part of the rule. The process of selecting and firing arule is known as the
Forward Chaining Cycle, and the forward chaining engine cycles repeatedly until it runs out of rules or arule instructsit to
stop. KnowledgeWorks forward chaining rules reside in agroup of rules, or context, and may have a priority number
associated with them for conflict resolution (choosing which of a set of eligible rules may fire).

3.1.2 Forward Chaining Syntax

Forward chaining rule bodies are defined by:

<body> :: =
[: context <context-nane>]
[:priority <priority-nunber>]
<f orwar d-condi ti on>* --> <expressi on>*)

where <cont ext - nanme> is the name of a context which has already been defined (see 3.1.5 Control Flow) defaulting to
def aul t - cont ext, and <pri ori t y- nunber > isanumber (see 3.1.5 Control Flow) defaulting to 10.

The syntax for forward-conditionsis:

<forward-condition> ::=
<obj ect-condi ti on>
| (test <lisp-expr>)
| (not <forward-condition>+)
| (!l ogical <forward-condition>+)

<obj ect-condition> ::=
(<cl ass-name> <vari abl e> [ <obj ect -sl ot-condition>]*)
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<obj ect-slot-condition> ::=
<sl ot - nane> <terne

<obj ect - condi t i on> is an object-base match where the variables (introduced by "?") in <t er n» are bound (via
destructuring) to the corresponding data in the slot named by <sl ot - name>. <vari abl e>isasingle variable bound to the
object matched.

Note: "?" on its own denotes an anonymous variable which always matches.

(test <lisp-expr>) isaLisptest where<l i sp-expr>isany Lisp expression using the variables bound by other
conditions, and which must succeed (return non-nil) for the condition to match. Computationally cheap Lisp tests can
frequently be used to reduce the search space created by the object base conditions. Lisp tests, and any functions invoked by
them, should not depend on any dynamic global data structures, as changing such structures (and hence the instantiations of
the rule) will beinvisible to the inference engine. Lisp tests can depend on the values of slots in objects matched by
preceding object-base conditions only if the values are bound to variablesin the rule using the <obj ect - sl ot - condi ti on>
syntax. They cannot depend on values obtained by calling sl ot - val ue or areader function.

(not <forward-condition>+) issimply anegated condition. A negated condition never binds any variables outside its
scope. Variables not bound before the negation will remain unbound after it.

(1 ogi cal <forward-condition>+) isused toindicate clauses that describe the logical dependencies amongst objects.
See 6.4 Logical Dependencies and Truth Maintenancefor more details.

Note that if aforward chaining rule contains any conditions at al then it must contain at |east one object base reference of the
form:

(<cl ass-nane> <variable> ...)

The syntax for expressionsis.

<expression> ::=
<f orwar d- condi ti on>
| (erase <vari abl e>)
| (assert (<cl ass-name> <vari abl e>
[ <sl ot - name> <ternp] *))
| (context <context-list>)
| (return)
| (<l'isp-expr> <ternp*)
| <goal >

<f orwar d- condi t i on> isaforward condition which must succeed for execution of the action part of the rule to continue.

(erase <vari abl e>) removesthe instance bound to <var i abl e> from the knowledge base. It isan error if <vari abl e>
is bound to anything but a KnowledgeWorks instance.

(assert (<class-name> <vari abl e> [<sl ot -name> <ternp] *)) isan assertion which modifies the contents of
the object base, whereif <vari abl e> is unbound a new object of the given class with the given slot-values is created, and if
it is bound, the object to which it is bound has its slots modified to the given values.

(context <context-Iist>) addsthegiven list of contextsto the top of agenda (see 3.1.5 Control Flow).

(return) passescontrol to the top context on the agenda and removes it from the agenda (see 3.1.5 Control Flow).

(<lisp-expr> <ternp*) bindstheresult or results of calling <I i sp- expr > to the <t er m»>swith execution of the rule
terminating if any bindingsfail (if no <t er n>s are given execution will always continue).

<goal > may be any backward chaining goal expression (see 3.2 Backward Chaining).

Note that in the action part of arule, only backward chaining goals and object base matches invoke the backward chainer.
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3.1.2.1 Example

(defrule nove-train :forward
icontext train
(train ?train position ?train-pos)
(signal ?signal position ?signal-pos
col or green)
(test (= 7?signal-pos (1+ ?train-pos)))
-->
((format t "~%rain noving to position ~s"
?si gnal - pos))
(assert (signal 7?signal color red))
(assert (train ?train position ?signal-pos)))

specifiesthat if thereisatrain with agreen signal directly in front then the train may move on and the signal changes to red.

3.1.3 Defining Forward Chaining Rules

Forward chaining rules may be defined and redefined incrementally. When redefined all the instantiations of therule are
recreated. This means that during execution of a rulebase the redefinition capability should be used with care as previously
fired instantiations will reappear and may fire again.

When aruleisredefined it inheritsits order (with respect to the or der conflict resolution tactic) from itsinitial definition. If
thisis not required, the rule should be explicitly undefined before being redefined.

A forward chaining rule may be undefined by entering:

(undefrul e <rul e-nanme>)

A warning will be given if the rule does not exist.

3.1.3.1 Example

(undefrul e nmove-train)

3.1.4 The Forward Chaining Interpreter

The forward chaining rule interpreter may be invoked by the Lisp function:

(infer [:contexts <context-list>])

where <cont ext - | i st > isalist of contexts where control is passed immediately to thefirst in the list, and the rest are
placed at the top of the agenda. The object base may or may not be empty when the forward chainer is started. Thei nf er
function returns the final cycle number. When not specified, <cont ext - | i st > defaultsto (def aul t - cont ext ).

3.1.5 Control Flow

3.1.5.1 The Agenda

The agendais essentially a stack of rule groups (called contexts) which are still awaiting execution. The initia invocation of
the forward chainer and any subsequent rule can cause contexts to be added to the top of the agenda. During normal
execution the forward chainer ssimply proceeds down the agenda context by context. When the agendais empty, passing
control on will terminate the execution of therule interpreter. Thisisa proper way to exit the forward chainer.
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3.1.5.2 Contexts

Contexts are the groups into which rules are partitioned. The context def aul t - cont ext aways exists. Contexts are defined
by:

<context> ::=
(def cont ext <cont ext - name>
[:strategy <CRS>]
[:auto-return t | nil]
[:neta <meta-actions>])
[: docunentation <doc-string>])

where <cont ext - name> isasymbol, <CRS> isaconflict resolution strategy defaultingto (priority recency order)
(seebelow). If : auto-returnissettot (the default) then when the context has no more rulesto fire, control passes to the
next context on the agenda, but if itisni | an error occurs (arulein the context should haveissued a(r et ur n) instruction
explicitly). The: net a option is necessary only if the default behavior of the context isto be modified and is explained in
6.1.1 Meta Rule Protocol. If : docunent at i on isgiven, then doc-string should be a string and the value can be retrieved
by calling the function docunent at i on with doc-type cont ext .

3.1.5.3 Conflict Resolution

Every context hasits own conflict resolution strategy, specified in the def cont ext form. A conflict resolution strategy is an
ordered list of conflict resolution tactics. A conflict resolution tactic may be any of the following:

priority Instantiations of ruleswith the highest priority are preferred.

-priority Instantiations of rules with the lowest priority are preferred.

recency The most recently created instantiations are preferred.

-recency The least recently created instantiations are preferred.

order Instantiations of rules defined/loaded earliest are preferred. This favors the topmost rulesin a
file.

-order Instantiations of rules defined/|oaded |atest are preferred.

specificity The most specific rules are preferred (specificity is a score where a point is awarded for every

occurrence of avariable after the first, every Lisp test, and every destructuring expression; the
highest score wins).

-specificity The least specific rules are preferred.

nmea MEA stands for Means End Analysis. Instantiations are preferred where the object
corresponding to the topmost object-matching condition is more recently modified.

- mea Instantiations are preferred where the object corresponding to the topmost object-matching
condition is less recently modified.

| ex LEX stands for LEXicographic. Each instantiation is represented by the (in descending order)
sorted list of the most recently modified cycle numbers of the objects in the instantiation; these
lists are compared place by place with an instantiation being preferred if it first has alarger
number in a particular position, or if it runs out first (hence the analogy with lexicographic
ordering).

- | ex The converse of the above.

Thetactics are applied successively starting with the left-most until only one instantiation is left or until all tactics have been
applied when it is unspecified which of the resulting set is chosen. For example, using the strategy (priority recency)
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first al the instantiations which are not of the highest priority rule or rules (as given by the rule's priority number) are
discarded and then all instantiations which were not created in the same forward chaining cycle as the most recently created
instantiation will be discarded. If more than one instantiation is left it is unspecified which will be selected to fire.

Note that the strategy (| ex speci ficity) isequivalent to the OPS5 strategy LEX and (nea | ex specificity) is
equivalent to the OPS5 strategy MEA, hence the borrowing of these terms. For further information on LEX and MEA in
OPS5 the reader is referred to Programming Expert Systemsin OPS5, by Brownston, Farrell, Kant and Martin (published by
Addison-Wesley). However, KnowledgeWorksis not heavily optimized to use the tactics nea, - mea, | ex or - | ex.

3.1.6 Examples

(defcontext trains
:strategy (priority recency order)
rauto-return t)

(defcontext trains)

These two definitions are in fact equivalent.

3.1.6.1 Defining Contexts
A context may be defined and redefined. Redefining a context will clear all the rulesin the context.

A context may be undefined and removed by entering:

(undef cont ext <cont ext - name>)

3.1.7 Forward Chaining Debugging

Forward chaining debugging may be turned on by typing:
(al | - debug)

and off by typing:
(no-debug)

When KnowledgeWorks is started, debugging is on. Debugging allows the actions of forward chaining rulesto be single-
stepped like backward chaining rules (see 3.2.7 Backwar d Chaining Debugging), and also records information on which
objects are modified by which rules. For information on how to use the debugging tools, refer to 5 The Programming
Environment.

3.2 Backward Chaining

3.2.1 Overview

Backward chaining involves trying to prove a given goal by using rulesto generate sub-goals and recursively trying to satisfy
those. The KnowledgeWorks backward chaining engine is an extension of the LispWorks Common Prolog system which can
match directly over KnowledgeWorks CLOS objects (the object base). All the standard Common Prolog facilities and built in
predicates are available. For more detailed information the reader isreferred to the Appendix A: Common Prolog. Note
that all the different ways of proving a particular goal are defined together in the same form.
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3.2.2 Backward Chaining Syntax

Backward chaining rule bodies are defined as.

<body> ::= <cl ause>+
<cl ause> ::= (<goal > <-- <expression>*)
<goal > ::= (<rul e-nanme> <ternp*)

In each sub-clause of the rule, the goal must have the same arity (number of arguments). Within each <t er n»> destructuring
isallowed and variables are introduced by ? (and ? on its own denotes the anonymous variable which aways matches).
<expr essi on> isasdefined in 3.1.2 Forward Chaining Syntax.

3.2.2.1 Example

(defrule link-exists :backward
((link-exists ?townl ?town2)
<= -
(or (link ?link townl ?townl town2 ?town2)
(link ?link town2 ?townl townl ?town2))

(cut)) ((link-exists ?townl ?town2)
<= -

(route-exists ?townl ?town2)))

which saysthat alink exists between two towns either if there isalink object between them in the object base or if thereisa
route between the towns. Ther out e- exi st s predicate would be defined by another backward chaining rule, or might bein
the Prolog database.

3.2.3 Objects

Backward chaining rules may refer to the object base using the standard

(<cl ass- name> <vari abl e> [ <sl ot - name> <t er np] *) syntax, and these expressions are instantiated directly
without creating any sub-goals. The <cl ass- nane> of any CLOS class or KnowledgeWorks structure may not coincide with
any backward chaining <r ul e- name>. The Common Prolog database may be used to record factual information but it is
distinct from the object base in that it may contain variables, and anything in it isinaccessible to the forward chaining rule
preconditions.

3.2.4 Defining Backward Chaining Rules

Backward chaining rules may be defined and redefined incrementally.

3.2.5 The Backward Chaining Interpreter

The backward chaining interpreter can be invoked from Lisp by the following functions:
(any expr-to-instantiate expr-to-prove)

which finds any solution to expr-to-prove and instantiates expr-to-instantiate, and:
(findall expr-to-instantiate expr-to-prove)

finds all the solutions to expr-to-prove, instantiates expr-to-instantiate for each and returnsthesein alist.

For other interface functions to be called from Lisp the reader is referred to Appendix A: Common Prolog.
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From the action part of aforward chaining rule the backward chainer is called implicitly when a CLOS match or goal
expression isused. The action part of forward chaining rules and the antecedents of backward chaining rules are syntactically
and semantically identical.

3.2.5.1 Examples

(any '(?x is in (12 3)) '(menber ?x (1 2 3)))
returns:

(Lisin(123))
The following expression:

(findall '(?x is in (12 3)) '(menber ?x (1 2 3)))
returns:

((Lisin(123)(2isin(123)(3isin(123))

3.2.6 Edinburgh Prolog Translator

Edinburgh syntax Prolog files may be compiled and loaded if they are given . pl asafile extension. These are completely
compatible with the KnowledgeWorks backward chaining rules. For more details refer to A.10 Edinburgh Syntax.

3.2.7 Backward Chaining Debugging

Backward chaining debugging follows the Prolog four port model. Backward chaining rules may be "spied” (thisisaProlog
term which corresponds to tracing and single-stepping) which puts a break-point on them and means they can be single-
stepped when they are invoked. When forward chaining debugging is on, the action part of forward chaining rules can be
spied and single-stepped in the same way when they arefired. 5 The Programming Environment, explains thisin detail.
The leashing of the ports can be adjusted, details are to be found in A.7 Debugging.

3.3 Common Lisp Interface

Arbitrary Lisp expressions may be called from rules. See 3.1.2 Forward Chaining Syntax.
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The object base contains KnowledgeWorks CLOS objects (including relational database objects) and KnowledgeWorks
structures. KnowledgeWorks CLOS objects can be treated as ordinary CLOS objects and may be manipulated directly from
Lisp. KnowledgeWorks relational database objects may transparently retrieve their slot values from arelational database
using the LispWorks object-oriented relational database interface.

KnowledgeWorks structures are more efficient but reduced functionality CLOS objects similar in spirit to Lisp structures.
Values in the slots of these objects should not be destructively modified unless these values are themselves K nowledgeWorks
objects. Thisis because the rule interpreter keeps track of the changes to the dlots, and a destructive operation islikely to
bypass this process.

4.1 CLOS objects

A KnowledgeWorks CLOS class may not have a class name which coincides with any rule, context or KnowledgeWorks
structure (See 4.3 KnowledgeWor ks Structures). KnowledgeWorks CLOS classes fall into one of two categories, either
unnamed or named. Named objects can be given a name (or they use a default name) and can be referred to by name.
Otherwise, named and unnamed objects have equivaent functionality. CL OS objects may be made by the Common Lisp
function nake- i nst ance, taking the same arguments. An unbound slot will return : unbound until set.

Name clashes are arbitrated by * si gnal - kb- nane- cl ash* and signal an error by default. See the reference manual page.

4.1.1 Unnamed Classes

Unnamed classes may be defined by the macro def - kb- cl ass which takes the same arguments as the def cl ass macro. It
isidentical to using defclass and supplying the KnowledgeWorks mixin st andar d- kb- obj ect if none of the superclasses
aready containsit. The function make- i nst ance may be used to create instances of the class.

4.1.2 Named Classes

A named KnowledgeWorks CLOS class is defined by the macro def - named- kb- cl ass which is syntactically identical to
the Common Lisp def cl ass macro, and semantically identical with the exception that it adds a KnowledgeWorks mixin
classnaned- kb- obj ect if hone of the superclasses already contains it, and makes the default name for the objects be a
symbol generated from the class name. Classes defined by def - naned- kb- cl ass contain a name slot which those defined
by def - kb- cl ass do not.

The function nake- i nst ance can be given the initialization argument : kb- nane to specify aname. If not specified, a
default name is generated from the name of the class. All names must be distinct as regarded by eq. The function:

(get - kb- obj ect <nane>)

retrieves the instance from its name. The function:

(kb-nane <obj ect >)

returns the name of the given object.
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4.1.2.1 Examples

(def - named- kb-cl ass truck ()
((location :initarg :1ocation)
(destination :initarg :destination)))
(make-instance 'truck
:kb-name 'fordl
:location 'Canbridge)

creates the instance #<KB- OBJECT FORD1>.
(make-instance 'truck :location 'London)
creates the instance #<KB- OBJECT TRUCK123>, and:
(get -kb-object 'fordl)
returns #<kKB- OBJECT FORD1> and:
(kb-nane (get-kb-object 'fordl))
returns FORDL. The class definition:
(defclass truck (named-kb-object) ...)
would have been identical except that the second truck would have been given a name such as OBJECT345 rather than

TRUCK123 (asdef - named- kb- cl ass overrides the inherited initform for the kb-name slot ( gent enp " OBJECT") witha
more specific one (gent enp <cl ass- nane>) ).

4.2 Relational Database Objects

A CLOS/SQL class may also be given the KnowledgeWorks mixin class, enabling rules to refer to these objects asiif there
were no database present. However, their database functionality carries over transparently. For example, consider the case
where a slot in the database class is designated for deferred retrieval from the database. When the rulebase queries the
contents of the dot, a database query will automatically be generated to retrieve and fill in the value of the dlot, and the
rulebase will continue as if the value had been therein the first place.

Details of the LispWorks Common SQL interface can be found in the LispWorks® User Guide and Reference Manual.

4.2.1 Example

(sql : def-viewcl ass vehicle
(standar d- db- obj ect st andard-kb-obj ect)
((vehicle_no :db-kind :key)
(keeper)
(owner :db-kind :join
:db-info (:home-key : keeper
:foreign-key person_id
iretrieval :deferred
:join-class person))))

defines a database class vehi cl e where the per son object in the keeper dot isretrieved from the per son tablein the
database using the value of the keeper dot as key, only when queried. Inthelist of superclasses, st andar d- kb- obj ect
should appear after sql : st andar d- db- obj ect .
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4.2.2 Extended Example

The following example is a complete segment of code which allocates person objects to vehicle objects. Note how once the
class definitions have been made, the rules do not in any way reflect the fact that there is an underlying database. The
example output assumes a database initialized by the following SQL statements:

drop table VEH CLE ;
create table VEH CLE

(PLATE CHAR(8) NOT NULL, MAKE CHAR(20),

PRI CE | NTEGER, OMNER CHAR(20) );

grant all on VEH CLE to public ;
insert into VEH CLE val ues

(' E265 FOO, 'VAUXHALL', 5000, '');
insert into VEH CLE val ues

(" XDG 792S', 'ROLLS, 50000, '');
insert into VEH CLE val ues

('F360 OOL', 'FORD , 4000, 'PERSEPHONE');
insert into VEH CLE val ues

(' H151 EEE', 'JAGUAR , 15000, '');
insert into VEH CLE val ues

(' Gr22 HAD', 'SKODA', 500, '');

drop tabl e PERSON ;

create tabl e PERSON
(NAVE CHAR(20) NOT NULL, SALARY | NTEGER, VEH CLE CHAR(8),
EMPLOYER CHAR(20) ) ;

insert into PERSON values ('FRED , 10000, '', 'IBM);
insert into PERSON val ues (' HARRY', 20000, '', 'FORD);
insert into PERSON values ('PHOEBE , 5000, '', '' );
insert into PERSON values (' TOM, 50000, '', 'ACME );
insert into PERSON val ues

(' PERSEPHONE' , 15000, 'F360 OOL', 'ICL');

drop tabl e COVPANY ;
create tabl e COWPANY

(NAME CHAR (20), PRODUCT CHAR(10) );
insert into COVWANY values ('I1BM, 'COWUTERS );
insert into COVPANY values (' FORD , 'CARS);
insert into COWANY values ('ICL'", ' COWUTERS );
insert into COVPANY val ues (' ACME' , ' TEAPOTS');

Below is an example rulebase that analyzes the database and outputs a suggestion as to which vehicle should be allocated to
which person. The full code and the SQL statementsto set up the database are included in the examples distributed with
KnowledgeWorks.

(i n-package "KW USER")

;;: the vehicle class nmaps onto the car table in the
;;; database owner is a join slot which | ooks up the
7, owner person object

(sql : def-viewclass vehicle
(sql : st andar d- db- obj ect st andar d- kb- obj ect)
((numnber-pl ate :accessor vehicl e-nunber-plate
:type (string 8)
:db- ki nd : key
:colum pl ate)
(make :accessor vehicl e- nake
:type (string 20)
:db- ki nd : base
: col um nake)
(price :accessor vehicle-price
:type integer
:db-ki nd : base
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:columm price)
(owner-nane :type (string 20)
:db-ki nd : base
: col um owner)
(owner :accessor vehicl e-owner
:db-kind :join
:db-info (:hone-key owner-nane
:forei gn-key nane
:join-class person
:set ni
:retrieval :deferred))))

the person class maps onto the person table in the
dat abase

vehicle is a join slot which | ooks up the owned
vehi cl e obj ect

conpany is a join slot which | ooks up the conpany
obj ect

(sql : def-vi ewcl ass person
(sql : st andar d- db- obj ect st andar d- kb- obj ect)
((nanme :accessor person-nane
:type (string 20)
:db- ki nd : key
: col um nane)
(sal ary :accessor person-salary
:type integer
:db-ki nd : base
:colum sal ary)
(vehicl e-nunber-plate :type (string 8)
:db- ki nd : base
: col um vehicle)
(vehicle :accessor person-vehicle
:db-kind :join
:db-info (:hone-key vehicl e-nunber-plate
:forei gn-key nunber-plate
:join-class vehicle
:set ni
:retrieval :deferred))
(enpl oyer :type (string 20)
:db- ki nd : base
: col um enpl oyer)
(conpany :accessor person-conpany
:db-kind :join
:db-info (:hone-key enpl oyer
:forei gn-key nane
:join-cl ass conpany
:set ni
:retrieval :deferred))))

the conpany class maps onto the conpany table in
t he dat abase

(sql : def -vi ewcl ass conpany
(sql : st andar d- db- obj ect st andar d- kb- obj ect)
((nanme :accessor conpany-nane
:type (string 20)
:db- ki nd : key
: col um nane)
(product :accessor conpany-product
:type (string 10)
:db-ki nd : base
:col um product)))

here we assune we have a database connected with
the correct data init - if we do we retrieve al
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the person and vehicl e objects but conpany objects
will be retrieved only when needed by querying
the conpany slot of the person objects

(if sql:*default-database*
(progn (sql:select 'vehicle)
(sql : sel ect 'person))
(format t
"~ ease connect to a database with
contents ~ created by file data.sql"))
to store which vehicles a person can drive
(def -kb-struct vehicl es-for-person person vehicl es)
(defcont ext dat abase-exanple :strategy (priority))

for every person initialize the list of vehicles they
can drive

(defrule init-vehicles-for-person :forward
:cont ext dat abase- exanpl e
(person ?person vehicle nil)
-->
(assert (vehicles-for-person ? person ?person vehicles nil)))

for every vehicle a person can drive which has not yet
been included in the list, add it to the |ist

(defrul e vehicle-for-person :forward
:cont ext dat abase- exanpl e
(person ?person vehicle nil)
(vehicle ?vehicle owner nil)
(vehicl es-for-person ?c-f-p
person ?person
vehi cl es ?vehi cl es)
(test (not (menmber ?vehicle ?vehicles)))
has it been included?
-->
(vehi cl e- ok-for-person ?vehicle ?person)
check if ok to drive vehicle
(assert (vehicles-for-person ?c-f-p vehicles
(?vehicle . ?vehicles))))

rul es expressing what vehicles a person can drive:
if they have no enployer they can only drive a
Skoda otherwi se they will refuse to drive a Skoda
anyone will drive a Rolls or a Jaguar

they'll only drive a Ford or Vauxhall if salary is
| ess than 40k.

(defrul e vehicl e-ok-for-person : backward
((vehi cl e- ok-for-person ?vehicle ?person)
<- -
(person ?person conpany nil)
(cut)
(vehicl e ?vehicle nake "SKODA"))
((vehicl e- ok-for-person ?vehicle ?person)
<- -
(vehicle ?vehicle nake " SKODA")
(cut)
(fail))
((vehicl e- ok-for-person ?vehicle ?person)
<- -
(or (vehicle ?vehicle make "ROLLS")
(vehicle ?vehicle nmake "JAGUAR'))
(cut))
((vehicl e- ok-for-person ?vehicle ?person)
<= -
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(or (vehicle ?vehicle nmake "VAUXHALL")
(vehicle ?vehicle make "FORD'))

(person ?person sal ary ?sal ary)

(test (< ?salary 40000))))

next to rules are just sinple allocation rules,
trying out each possibility until one fits

(defrul e alloc-vehicl es-to-persons : backward
((all oc-vehi cl es-to-persons ?al | ocs)
<- -
(alloc-internal nil nil nil ?allocs)))

(defrule alloc-internal :backward
((all oc-internal ?done-persons ?done-vehicles
?al l ocs ?all ocs)
<= -
(not (and (vehicl es-for-person ? person ?person)
(not (nenber ?person ?done-persons))))
(cut))
((all oc-internal ?done-persons ?done-vehicles
?al l ocs-so-far ?allocs)
<= -
(vehicl es-for-person ? person ?person
vehi cl es ?vehi cl es)
(not (nenber ?person ?done-persons))
(menber ?vehicl e ?vehicl es)
(not (nenber ?vehicle ?done-vehicles))
(all oc-internal (?person . ?done-persons)
(?vehicl e . ?done-vehi cl es)
((?person . ?vehicle) . ?allocs-so-far)
?allocs)))

find a solution and print it out

(defrule find-solution :forward
:cont ext dat abase- exanpl e
ipriority 5
(not (not (vehicles-for-person ?)))
-->
(al | oc-vehicl es-to-persons ?sol ution)
((dolist (pair ?solution)
(format t "~%A drives ~A"
(person-nane (car pair))
(vehicl e-nunber-plate (cdr pair))))))

Below is sample output from the rulebase with SQL recording turned on to demonstrate the SQL statements that are
automatically passed to the database by manipulating the objects:

KW USER 53 > (infer :contexts '(database-exanple))

( SELECT VEHI CLE. PLATE, VEHI CLE. MAKE, VEHI CLE. PRI CE, VEH CLE. OOWER FROM VEHI CLE
VWHERE ( VEH CLE. PLATE = ' F360 OOL'))

( SELECT VEHI CLE. PLATE, VEHI CLE. MAKE, VEHI CLE. PRI CE, VEH CLE. OOWER FROM VEHI CLE

WHERE ( VEHI CLE. PLATE = ''))

( SELECT VEHI CLE. PLATE, VEHI CLE. MAKE, VEHI CLE. PRI CE, VEHI CLE. OANER FROM VEHI CLE
WHERE (VEHI CLE. PLATE = ''))

( SELECT

PERSON. NAME, PERSON. SALARY, PERSON. VEHI CLE, PERSON. EMPLOYER

FROM PERSON WHERE ( PERSON. NAME = ''))
( SELECT VEHI CLE. PLATE, VEHI CLE. MAKE, VEHI CLE. PRI CE, VEHI CLE. OANER FROM VEHI CLE
WHERE (VEHI CLE. PLATE = ''))
( SELECT

PERSON. NAME, PERSON. SALARY, PERSON. VEHI CLE, PERSON. EMPLOYER

FROM PERSON WHERE ( PERSON. NAME = ''))

( SELECT VEHI CLE. PLATE, VEHI CLE. MAKE, VEHI CLE. PRI CE, VEHI CLE. OAONER FROM VEHI CLE
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WHERE ( VEHI CLE. PLATE = ''))

( SELECT

PERSON. NAME, PERSON. SALARY, PERSON. VEHI CLE, PERSON. EMPLOYER
FROM PERSON WHERE ( PERSON. NAME = ''))

( SELECT

PERSON. NAME, PERSON. SALARY, PERSON. VEHI CLE, PERSON. EMPLOYER
FROM PERSON WHERE ( PERSON. NAME = ''))

( SELECT

PERSON. NAME, PERSON. SALARY, PERSON. VEHI CLE, PERSON. EMPLOYER
FROM PERSON WHERE ( PERSON. NAME = ' PERSEPHONE' ))

( SELECT COMPANY. NAVE, COVPANY. PRODUCT FROM COVPANY

WHERE ( COVPANY. NAME = ' FORD ))

( SELECT COMPANY. NAVE, COVPANY. PRODUCT FROM COVPANY

WHERE ( COVPANY. NAME = ' ACME'))

( SELECT COMPANY. NAVE, COVPANY. PRODUCT FROM COVPANY

WHERE ( COVPANY. NAME = ' | BM))
( SELECT COMPANY. NAVE, COVPANY. PRODUCT FROM COVPANY
WHERE ( COVPANY. NAME = ' '))

HARRY drives E265 FQOO
TOM drives XDG 792S
FRED drives H151 EEE
PHOEBE drives G722 HAD
26

4.3 KnowledgeWorks Structures

An optimization for improved performance is to replace CL OS objects by KnowledgeWorks structures when the objects are
not needed outside the rules, or the full power of object-oriented programming is not required. Within rulesthey behave the
same, although they are not proper CLOS objects. Thisis discussed in detail in 6.2 Optimization.
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The KnowledgeWorks programming environment is designed for the development of rules. KnowledgeWorks applications
will typically contain a mixture of programming styles and so the LispWorks programming environment is available from the
menus on the KnowledgeWorks Podium. This chapter deals with KnowledgeWorks specific tools but see the LispWorks IDE
User Guide for more details on the LispWorks tools.

KnowledgeWorks Podium

% LispWorks 6.0.0
File Edit Tools EnowledoeWorks ‘wWarks D Hiskory  Windows  Help

B wp QYA CHFOQBEO I ALE S 8

Active Windaow @ Listener 1

All KnowledgeWorks windows except the Podium can be closed independently of the others. You can switch between
windows by choosing Works > Windows > window-name.

5.1 The KnowledgeWorks Listener

KnowledgeWorks Listener

% Knowledgeworks Listener 1

The KnowledgeWorks Listener is obtained by choosing KnowledgeWorks > Listener. Thistool is based on the LispWorks
Common Prolog Logic Listener (see Appendix A: Common Prolog for further details). Input is taken as being agoal
expression to be satisfied unless no predicate of that name and arity (number of arguments) existsin which case it istaken as
aLisp expression. That is, the input may be either:

<expressi on>

as defined in 3.1 Forward chaining, or:
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<l i sp-expr>

with the former interpretation taking priority when ambiguous. Interaction is Prolog-style, so when the bindings which
satisfy agoal are printed, pressing Ret ur n terminates execution, and entering ; (semi-colon) and Ret ur n (or just clicking
on the Next button at the bottom) looks for the next solution to the goal .

TheFile, Leashing and Spy menus behave as for the Common Prolog Logic Listener (see Appendix A: Common Prolog)
and the Values, Debug and History menus behave as for the Lisp Listener (see the LispWorks IDE User Guide).

5.2 The Editor
KnowledgeWorks Editor

‘ Editor 1 - animal-rules. lisp
- - . @ oo Iy 9 %
Tent | Cutprat || Buffers || D efinitions || Changed Definitians || Find Definitiun3|

{assert {node 7node animal nil yes—-node ?yes-node no-node ?no-node
question ?question))}}

| >

[{defrule game-finished :forward
:priority 15
{game—-ouer ¥q}
—=>

{erase ¥q)
{test (not {capi:confirm-yes-or-no "Pla
(return))

e BACKWARD CHAIWIWG -------———"-"—"—"—"—"""""""—"——- » ¥
CODE-PAGE - animal-rules lizp  KW-USERY [Lisp] 60-71 [113] C:\Program FileshLispia'ork s\iB4E-0-0-0%exarmplesik whanimalsani

The KnowledgeWorks Editor is created by choosing KnowledgeWorks > Editor. It isthe same as the LispWorks Editor tool.
Please see the Lisp\Works IDE User Guide for more information on the editor tool and the Editor User Guide for information
on the various editing commands.

5.3 Clearing KnowledgeWorks

The KnowledgeWorks abject base (all the KnowledgeWorks CLOS objects and any optimized structures) may be cleared by
choosing Memory > Clear Objects from the KnowledgeWorks Listener, or by calling the functionr eset .

K nowledgeWorks rules may be cleared by choosing Memory > Clear Rules from the KnowledgeWorks Listener, or by calling
thefunction cl ear - r ul es. Clearing the rules does not remove the default context def aul t - cont ext but al therulesin it
are removed.

KnowledgeWorks object base and rules may be cleared by choosing KnowledgeWorks > Memory > Clear Objects and Rules
from the KnowledgeWorks Listener, or by calling the function cl ear - al | . CLOS class definitions remain in effect.
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5.4 The System Browser
KnowledgeWorks System Browser

% System Browser 1

& - B

s [AMIMAL

Tree |Te:-:t Preview | Output

= el AMIMAL
|- el ANIMAL-PROG
animal-rules. lizp
=1 e ANIMAL-DATA

animal-objz. lizp

Dezcrption:

Mame: AMIMaL

Fathname: C:\Program FilezhLizptadorkz\ibhE-0-0-0hexampleshkowhanimalt
Flags:

Ready.

The KnowledgeWorks system browser is obtained by choosing KnowledgeWorks > Systems. It isthe same asthe LispWorks
System Browser, but includes new types of system:

 : kb- syst em which are reloaded when the KnowledgeWorks rules are cleared (see 5.3 Clearing K nowledgeWorks).

* :kb-init-system which are reloaded when the KnowledgeWorks object baseis cleared (see 5.3 Clearing
KnowledgeWorks).

For more information on LispWorks systems, see the Common Defsystem chapter in the LispWorks® User Guide and
Reference Manual. For more information about the System Browser tool, see the LispWorks IDE User Guide.

5.5 The Class Browser
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KnowledgeWorks Class Browser

* Class Browser 1

|Kw-USER:NODE v X3

| Hierarchy || Superclaszes || Sul:u:lasses| Slots | [nikargs || Funchions || Frecedence
Include Inhented Slots

Filter - M Matches B

EhALPHA-SLOT-TABLE
Ea-USER:ANIMAL
EWw-LUSER:NO-MODE
Er-USER:LUESTION
EWwRECEMNCY

ki -USER:YES-NODE

Drezchption:

From Claszes: Kw-USER::NODE
Slat Mame: Fw-USER:ANIMAL
Type: T
Iritargs: AMNIMAL
[rutfarm: MIL
Readers: Fhw/-USER:NODE-aM[MAL
Wwhiters: [SETF K:W-USER:MODE-AMIMAL)
Allocation: [ INSTAMCE

The Class Browser is obtained by choosing KnowledgeWorks > Classes. It isthe same asthe LispWorks Class Browser
except that:

* It appearswith aninitial focus on st andar d- kb- obj ect .

» When looking at a KnowledgeWorks class the Works > Classes menu and context menu contain an Inspect Instances
command which allows you to look at the instances of the class.
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I nspecting instances from the Class Browser

' Class Browser 1

= -

| EWCSTANDARD-EEB-OBJECT

Superclaszes: Subclazzes:

Ewd-LISER:

Dezcription:

FPackage: Kw-USER
Mame: MODE
Metaclazs: STAMDARD-CLASS
Aecezzibiliby: INTERMAL

|Heady.

This raises an Inspector tool with alist of al the instances.

STAMDARD-OBJECT Ex:NAMED-KB-OBJECT

Browse - Class
Class

Clip

Copy
Docurnentakion
Find Source
Inspect

Liskten

Browse Metaclass

Inspeck Inskances

v X

Higrarchy | Superclaszes || Subclazzes || Slots || [nikargs || Funchions || Frecedence
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K nowledgeWorks I nstances | nspector

“#% Inspector 1

: =
|:|:|r'|3 Lizt
Filter -

-

M Matches 9

Walue

L I e g N P L B

KW -USER:
kW -USER:
H<kWwW-USER:
H<kEMw-USER:
H<kEW-USER:
H<KWwW-USER:
KW -USER:
kW -USER:
H<kWwW-USER:

MODE 22248327
MNODE 2224835F
MODE 222C7455F
MODE 222074877
MODE 222C7584F:
MODE 222C7AE 7
MNODE 222C7B1F>
MODE 222C7B57:
MODE 222C7CRF -

|Heady.

LIST: (# <kW-USER::MNODE 22245927 > # <KW-L

Any of the instances displayed in the lower pane may itself be inspected by double-clicking onit.

Other options available in the Class Browser include:
» Superclasses and Subclasses tabsto draw a graphs of the superclasses or subclasses of the class being looked at.
* Slots and Initargs tabsto show how the instances can be accessed and initialized.
* Functions tab to show the generic functions or methods defined on this class, either directly or by inheritance.

Additionally the Works > Classes menu contains a Browse Metaclass command which browses the class of this class.

Further details can be found in the LispWorks IDE User Guide.

5.6 The Objects Browser
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K nowledgeWorks Objects Browser

“#% Objects Browser 1

[ ‘_| -

Current cocle number: [ B Shiow Inferencing State: | :DEFALLT

Preset quer/pattern: | Custom w
Llueny:  [[MODE Yobject)
Fattern:

[NODE #<MODE 20714347)
MODE #<MODE 2071430F
(MODE #<MODE 222C7483F ]
[MODE #$<MNODE 22207477
[NODE #<NODE 222C7AAF ]
[NODE #<MODE 222C7AE )
[NODE #<MODE 222C7B1F>)

IMOME HebOnE 222 7RET-

CLOS object: Existed at ztart
Slats:

AMIMAL : HIL

GQUESTION : "Does it have stripesy"’
YES-MODE : #<MODE 222C7B1F >
MO-MODE : #<MODE 222C7A77

|Heady.

The Objects Browser is obtained by choosing KnowledgeWorks > Objects. Any <expr essi on> (See 3.1 Forward
chaining) may be entered into the Query pane. This expression may be a query about the object base or any expression for
the backward chainer to prove. The Pattern pane contains the pattern to be instantiated for each solution of the query. If left
blank, the pattern used is the query itself.

The Show Inferencing State dropdown allows you to choose which named inferencing state is used to supply the object base
for the query.

The Preset query/pattern pane offers a convenient way to examine instances on a per-class basis. All the instances of a class
class-name known to KnowledgeWorks (either a CLOS class or a KnowledgeWorks structure class) may be examined by
selecting class-name, and all the instances in the object base may be viewed by selecting All classes.

The package used to read and print symbols may be modified by choosing Tools > Preferences... > Objects Browser >
Package and entering a package name into the Package pane. Clicking OK will update the tool.

The pane below the query displays all the instantiations of the query, and if the entries refer to an object (so are of the form
(<cl ass- name> <obj ect> ...) orjust <obj ect >) double-clicking on them will display the slot names and values, and
information on when the object was created or modified (if debugging is turned on) in the bottom pane. The selected query
item may be inspected by choosing Works > Instantiations > Inspect.

The Objects Browser may be updated by positioning the mouse in either the Query or the Pattern pane and pressing Ret ur n
or by choosing Tools > Refresh.
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5.7 The Rule Browser

KnowledgeWorks Rule Browser

“% Rule Browser 1
xS DEFALLT-CONTERT

Filter M Matches 5

Kwd-USER:ANIMAL-QUESTION
Kwd-USER: GAME -FINISHED
Exd-USER::NEW-LUESTION

K- SER

S-W-QUESTION

The Rule Browser may be obtained by choosing KnowledgeWorks > Rules. It displays contexts and their rules. The
Contexts pane at the top allows you to select from a drop-down list either a forward chaining context or the specia pseudo-
context containing all the backward chaining rules. The Rules pane lists the rules for the selected context.

The Works > Context menu acts on the selected context. Choosing Works > Context > Find Source will bring up the
definition of the context in the file where it was defined, and choosing Works > Context > Gspy will bring up a Spy Window
(see 5.8 Debugging with the Environment) for the context, displaying the meta-interpreter (see 6.1.1 M eta Rule Protocol)
for the context if oneis defined. If debugging isturned on a meta-interpreter is always defined. Choosing Works > Context >
NoGspy will remove the Spy Window (see 5.8 Debugging with the Environment).

The Works > Rule menu acts on the rule selected in the lower pane. All rules may be edited by choosing Works > Rule > Find
Source. Spy Windows can be brought up or removed by choosing Works > Rule > Gspy. Forward chaining rules may have
Monitor Windows (see 5.8 Debugging with the Environment) brought up or removed by choosing Works > Rule > Monitor
(this command is disabled when a backward chaining rule has been selected). These are explained in 5.8 Debugging with the
Environment.

The package used for displaying symbols may be modified by choosing Tools > Preferences... > Rule Browser > Package
and entering a package name into the Package area. Clicking OK will update the tool.

5.8 Debugging with the Environment

5.8.1 Spy Windows
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KnowledgeWorks Gspy Window

% Rule Gspy 1 - KW-USER:: Y -N-QUESTION/4

[[CAPLCOMFIRM-YES-0OR-NO 0] PANSWER]
[COMMOMN-PROLOGERASE YCURREMT]
[[EW-USER:FIND-NEW-MODE YANSWER ... YMEW-CURRENT]
ASSERT [KW-USER::CURRENT-NODE Y1173 ..]]

(R -USER:Y-N-LQUESTION 70 . ]e

Spy Windows display graphically the actions or subgoals arule (either forward or backward chaining) will invoke when it
fires. A Spy Window may be obtained by selecting arulein the Rule Browser and choosing Works > Rule > Gspy or
choosing Gspy from the context menu.or by choosing KnowledgeWorks > Spy > Gspy in the KnowledgeWorks Listener.
Spying can be cancelled by closing the Spy Window or by choosing KnowledgeWorks > Spy > NoSpy or KnowledgeWorks >
Spy > NoSpy All from the KnowledgeWorks Listener.

Selecting one of the graph nodes in the top pane of the Spy Window displays the full text of the box in the pane below.
Choosing Gspy from the context menu brings up a Spy Window for the goal in the box.

When the rule being displayed fires, execution stops and the buttons at the bottom of the KnowledgeWorks Listener alow the
rule to be single-stepped. Clicking on the Creep button steps through the rule, and Leap advances to the end of the rule
(unless any of the intervening goals invoke another rule which has been spied). When single-stepping, a highlight marks the
action or goa being performed. When execution is suspended in this manner, any of the KnowledgeWorks tools or browsers
may be used.

More details on single stepping through rules are in Appendix A: Common Prolog.

5.9 Monitor Windows
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KnowledgeWorks Rule Monitor

“% Rule Monitor 1 - KW-USER::PLAY

Select ingtantiations

() All Urfired Instantiations Show Inferencing State: | \DEFAULT
(%) Matching Selected Conditions
[ SER:ROOT Kw-USER:: 7R KWwW-JSER::HMODE EM/-USER:?MNODE)

SER:CURRBENT-MODE COMMOM-PROLOG:? EW-USER::NODE COMMON-PROLOG: 7]

Mumber of instantiations matching selected conditions: 1

[nstantiation 1:
R = #<EWUSER:ROQT 222C79E T

YMODE = #<Kw-USER:NODE 222C7435F:
Y ="

Monitor Windows allow the preconditions of forward chaining rules to be monitored. They may be obtained by choosing
Works > Rule > Monitor or by choosing KnowledgeWorks > Spy > Monitor Rule from the KnowledgeWorks Listener.

Thetop part of the window isthe Select instantiations pane, as described below. The lower part displays alist of either fired
or unfired instantiations. Thislist is not kept up to dateif the rulebase is executing with debugging turned off. To examine a
binding in adisplayed instantiation, select the corresponding line and choose Works > Instantiations > Inspect. This shows
the objects themselves in a LispWorks Inspector tool, so double-clicking on one of the entries will cause that entry to be
inspected. Seethe LispWorks IDE User Guide for more details.

The Show Inferencing State dropdown allows you to choose which named inferencing state is used to find the instantiations.
When the All Unfired Instantiations button is selected, the unfired instantiations are displayed.

When the Matching Selected Conditions button is selected, the instantiations that match all of the selected preconditions are
displayed. The topmost shows the preconditions of the rule. Any conditions that are matched by the object base are
highlighted. This highlighting means the condition is matched without reference to any of the other conditions. A message
indicates the number of instantiations matching the highlighted preconditions. A group of preconditions matched individually
(hence highlighted) may not be matched together if, for instance, variables were bound across them.

If arule has the conditions, for example:

(person ?personl father ?person)
(person ?person2 son ?person)
(test (not (eq ?person nil)))

these would be displayed in the top pane of the Rule Monitor Window. The first two would be highlighted if the object base
contained a person object. But instantiations would only be displayed if there was aper son object with the samef at her
value as some (other) per son object hasson.

The selection of conditions may be toggled by Ieft-clicking. So in the above example the last condition could be selected also
by clicking on it, and there would be no instantiations displayed if the only consistent value of ?per son wasni | .
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5.9.1 Forward Chaining History
KnowledgeWorks Forward Chaining History

% F C History 1

Current cpcle number: [B Shiow Inferencing State: | :DEFALLT
Contexts FC Cycles

1  DEFAULT-COMTEXT 1 2 3 4 65 B

PLAY ] g
N-QUESTION N

AMIMAL-LUESTION
MEW-LLESTION
GAME-FINISHED

|Heady.

DEFAULT-COMTEXT

The Forward Chaining History may be viewed by choosing KnowledgeWorks > FC History. This displays the rules which the
forward chaining engine has fired. The left pane lists sequentially the contexts which have been executed, with the cycle
number in which they were entered. These can be clicked on to show in the right pane, the history for that context. The rules
init are listed down the | eft, and the cycle numbers along the top, forming atwo dimensional grid.

Each position in the grid indicates the status of the rulein that cycle. A colored box indicates that the rule fired. A half-
colored box indicates that the rule fired, but that the invocation of the backward chainer on the right-hand side failed at some
point. There can only be one colored or half-colored box per cycle. An outlined box indicates that the rule was in the conflict
set but was not chosen to fire. Absence of any icon indicates that the rule was not even in the conflict set.

If the forward chaining history is displayed while arule is executing (for example, while the rule is being single stepped) a
half-colored box is displayed as execution is not complete.

The Works > Rule menu can be used in the same way asin the Rule Browser, described in 5.7 The Rule Browser . It applies
to the selected rule in the FC Cycles pane.

The Show Inferencing State dropdown allows you to choose which named inferencing state is examined.

Thistool is hot available when debugging is turned off.

46



6 Advanced Topics

6.1 Control Flow

6.1.1 Meta Rule Protocol

The metarule protocol (MRP) reifies the internal actions of the forward chainer in terms of backward chaining goals. This
allows the user to debug, modify, or even replace the default behavior of the forward chainer. The basic hooks into the
Forward Chaining Cycle provided by the MRP include conflict resolution and rule firing. Each context may have a meta-rule
defined for it which behaves as a meta-interpreter for that context. For example, if no meta-rule is defined for a context it
behaves asif it were using the following meta-rule;

(defrul e ordi nary-context :backward
((ordinary-cont ext)
<- -
(start-cycle)
(instantiation ?instantiation)
(fire-rule ?instantiation)
(cut)
(ordi nary-context)))

This rule describes the actions of the forward chaining cycle for this context. Firstly st art - cycl e performs some internal
initializations and updates the conflict set. It isessential that thisis called at the start of every cycle. Next the preferred
instantiation is selected from the conflict set by the call toi nst anti ati on and isstored in the variable ?i nst anti at i on.
Therule corresponding to thisisfired (by fi r e- r ul e) and the recursive call to or di nar y- cont ext meansthat the cycleis
repeated. The cut isalso essential asit prevents back-tracking upon failure. Failure occurs when there are no more
instantiations to fire (thei nst ant i at i on predicate fails) and this causes control to be passed on as normal.

A meta-rule may be assigned to a context with the : met a keyword of the def cont ext form. The argument of the : net a
keyword isthe list of actions to be performed by the context. For example, a context using the above ordinary meta-
interpreter can be defined by:

(def context ny-context :nmeta ((ordinary-context)))

Thisimplicitly definesthe rule:

(defrul e ny-context :backward
((ny-cont ext)
<- -
(ordi nary-context)))

and whenever this context isinvoked, the rule of the same nameis called. The context could equally well have been defined
as.

(defcontext my-context :neta
((start-cycle)
(instantiation ?instantiation)
(fire-rule ?instantiation)
(cut)
(my-context)))
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Sometimesit is useful to manipulate the entire conflict set. For this purposethe action (conflict-set ?conflict-set)
will return the entire conflict set in the given variable, in the order specified by the context's conflict resolution strategy. The
actions:

(conflict-set ?conflict-set)
(menmber ?instantiation ?conflict-set)

are equivalent to:

(instantiation ?instantiation)

athough the latter is more efficient.

Now that the user has access to the instantiations of rules, functions are provided to examine them.

6.1.1.1 Functions defined on Instantiations

The following functions may be called on instantiations:

(i nst-rul ename ingtantiation)

which returns the name of the rule of which thisis an instantiation.

(i nst-token instantiation)

which returns the list of objects (the token) which match the rule. These appear in reverse order to the conditions they match.
(i nst-bi ndi ngs instantiation)

which returns an a-list of the variables matched in the rule and their values.

6.1.1.2 A Simple Example

This meta-rule displays the conflict set in amenu to the user and asks for one to be selected by hand on each cycle. Note that
we have to check both that there were some instantiations available, and that the user selected one (rather than clicking on the
Abort button).

(defrul e manual - cont ext :backward
((manual - cont ext)
<- -
(start-cycle)
(conflict-set ?conflict-set)
(test ?conflict-set)
are there any instantiations?
((select-instantiation ?conflict-set)
?instantiation)
(test ?instantiation)
did the user pick one?
(fire-rule ?instantiation)
(cut)
(manual - context)))

wherethe function sel ect -i nst anti at i on could be defined as:

(defun select-instantiation (conflict-set)
(tk:scrollable-menu conflict-set
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:title "Select an Instantiation:"
:nanme-function # (Il ambda (inst)
(format nil "~S ~S"
(inst-rul enane inst)
(inst-bindings inst))))

Now a context could be defined by:
(defcontext a-context :strategy ()

:meta ((manual -context)))

6.1.1.3 A Simple Explanation Facility

Meta-rules can a so be used to provide an explanation facility. A full implementation of the explanation facility described
here isincluded among the exampl es distributed with KnowledgeWorks, and is given also in B.2 Explanation Facility.

Suppose we have arule about truck scheduling of the form:

(defrule allocate-truck-to-load :forward
(load ?I size ?s truck nil destination
?d |l ocation ?loc)
(test (not (eq ?2d ?loc)))
(truck ?t capacity ?c load nil |ocation ?loc)
(test (> ?c 7?s))
-->
(assert (truck ?t load ?1))
(assert (load ?I truck ?t)))

and we wish to add an explanation by entering aform like:

(defexpl ain allocate-truck-to-Ioad

:why ("~S has not reached its destination
~S and ~ does not have a truck
al l ocated, ~ ~S does not have a | oad
al l ocated, and ~ with capacity ~Sis
able to carry the load, ~ and both
are at the sane place ~S"
?1 ?2d ?t ?c ?loc)

:what ("~S is scheduled to carry ~S to ~S"
2t ?1 2d)

: because ("A custoner requires ~S to be

noved to ~S' ?l ?d))

where the : why form explains why the ruleis allowed to fire, the: what form explains what the rule does and the : because
gives the ultimate reason for firing the rule.

The stages in the implementation are as follows:

» Defineamacro called def expl ai n to store the explanation information in, say, a hash-table keyed against the rule
name.

» Defineafunction add- expl anat i on takes an instantiation, fetches the explanation information from the hash-table and
the variable bindings in the instantiation, and adds the generated explanations to another global data structure,
something like:

(defun add-instantiation (inst)
(let ((explain-info
(gethash (inst-rul enanme inst)
*expl ai n-tabl e*)))
(when expl ain-info
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(do-the-rest explain-info
(inst-bindings inst))))))

Implement graphical tools to browse the resulting explanations.

Define a meta-interpreter for which will produce explanations, for example:

(defrul e expl ai n-context :backward
((expl ai n-cont ext)
<- -
(start-cycle)
(instantiation ?inst)
((add- expl anati on ?inst))
(fire-rule ?inst)
(cut)
(expl ai n-context)))

6.1.1.4 Reasoning with Certainty Factors

Another application of meta-rulesisin the manipulation of uncertainty. A full implementation of the uncertain reasoning
facility described below isincluded among the examples distributed with KnowledgeWorks, and also in B.3 Uncertain
Reasoning Facility.

In this example, we wish to associate a certainty factor with objectsin amanner similar to the MY CIN system (see Rule-
Based Expert Systems, B. G. Buchanan and E. H. Shortliffe, Addison-Wesley 1984). When we assert an "uncertain” object
we wish it to acquire the certainty factor of the instantiation which is firing. We define the certainty factor of an instantiation
to be the certainty factor of al the objects making up the instantiation multiplied together. Additionally, we wish rulesto have
an implication strength associated with them which is a multiplicative modifier to the certainty factor obtained by newly
asserted uncertain objects. The general approach is asfollows:

Define global variables* c- f act or * to hold the certainty factor of the current instantiation and *i npl i c- st rengt h*
to hold the implication strength of the rule, and a class of "uncertain” KnowledgeWorks objects:

(def -kb-cl ass uncertai n-kb-obj ect ()
((c-factor :initform (* *c-factor* *inplic-strength*)
:accessor object-c-factor)))

The uncertain objects should contain this class as amixin.

Define afunction to obtain the certainty factor of instantiations:

(defun inst-c-factor (inst)
(reduce '* (inst-token inst) :key 'object-c-factor))

Define a conflict resolution tactic to prefer either more or less certain instantiations (See 6.1.2 User -definable Conflict
Resolution for details).

Define ameta-rule to set the global certainty factor to the certainty factor of the instantiation about to fire:

(defrul e uncertai n-context :backward
((uncertain-context)
<- -
(start-cycle)
(instantiation ?inst)
((setq *c-factor* (inst-c-factor ?inst)))
(fire-rule ?inst)
(cut)
(uncertain-context)))
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 Define afunction implication-strength which setsthe variable *i npl i ¢- st r engt h* so that rules may set their
implication strength by calling the action:

((inplication-strength <numnber>))
A rule could be defined similarly to:

(defrule ny-rule :forward
(my-cl ass ?0bj 1)
(my-cl ass ?0bj 2)
-->
((inplication-strength 0.6))
(assert (ny-class ?0bj3)))

where the certainty factor of the new object ?obj 3 will automatically become:
(* (object-c-factor ?0bj1l) (object-c-factor ?obj2) O0.6)

While thisis an extremely simplistic version of uncertain reasoning, it suggests how a more elaborate treatment might be
approached.

6.1.2 User-definable Conflict Resolution

A conflict resolution strategy isalist of conflict resolution tactics. A conflict resolution tactic is afunction which takes as
arguments two rule instantiations, and returnst if and only if thefirst is preferred to the second, otherwiseni | . A conflict
resolution tactic may be defined by:

(deftactic <tactic-nane> {<type>} <lanbda-list> [<doc-string] <body>)

where <t act i ¢c- nane> isthe name of the tactic and of the function being defined which implementsit, and

<l anbda- | i st > isatwo argument lambda-list. <t ype> may be either : st ati ¢ or : dynami c, defaulting to : dynami c. A
dynamic tactic is one which looks into the objects which match the rule to make up the instantiation; a static one does not.
For example, atactic which prefers instantiations which match, say, truck objects to instantiations which do not could be
defined as static. However, if it looksinto the slot values of the truck object it should be defined as dynamic. Static tactics are
treated more efficiently but wrongly declaring atactic as static will lead to incorrect conflict resolution. If doc-string is

given, then it should be a string. The value can be retrieved by calling the function docunent at i on with doc-type
function.

It is an absolute requirement that there exist no instantiations for which:
(<tactic-name> <instantiationl> <instantiation2>)

and:
(<tactic-name> <instantiation2> <instantiationl>)

both return t . Consequently, for any single given instantiation:

(<tactic-name> <instantiation> <instantiation>)

must return ni | .

The function which defines a conflict resolution tactic should be computationally cheap asit is used repeatedly and frequently
to compare many different pairs of instantiations.
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6.1.2.1 Examples

The following tactic prefers instantiations with truck objects to ones withouit:

(deftactic prefer-trucks :static (instl inst2)
(flet ((truck-p (obj) (typep obj 'truck)))
(and (some #' truck-p (inst-token instl))
(notany #' truck-p (inst-token inst2)))))

Note that this tactic would be incorrect if we did not check that the second instantiation does not refer to any trucks
(otherwise it would always return t if both instantiations contain trucks). It can safely be declared as static as it does not ook
into the dots of the objects which make up the instantiation.

This tactic implements alphabetical ordering on rule names:

(deftactic al phabetical -rulenane :static (instl inst2)
(string< (synbol -nane (inst-rulenane instl))
(synbol -nane (inst-rul enane inst2))))

This tactic prefers instantiations which bind the variable ?x to zero:

(deftactic prefer-?x=0 :dynamic (instl inst2)
(flet ((fetch-?x (inst)
(cdr (assoc '?x (inst-bindings inst)))))
(and (eql O (fetch-?x instl))
(not (eql O (fetch-?x inst2))))))

Note that again we must not forget to check that ?x is not zero in the second instantiation. This tactic must be declared
dynamic as ?x must have been instantiated from the slots of one of the matched objects.

Thefinal tactic is for the example of uncertain reasoning and implements a method of preferring "more certain®
instantiations:

(deftactic certainty :dynamc (instl inst2)
(> (inst-c-factor instl) (inst-c-factor inst2)))

This tactic must be dynamic if the certainty factors of objects can be modified after creation. If thisisforbidden the tactic
could be defined as static. Then the context defined by:

(defcontext my-context :strategy (priority certainty))

will prefer instantiations of rules with higher priority or, if this does not discriminate sufficiently, instantiations which are
"more certain”.

6.2 Optimization

6.2.1 Forward Chaining

6.2.1.1 KnowledgeWorks Structures

A CLOS class may be replaced by a structure for increased speed when all the power of CLOS is not needed. Within the rule
interpreter the structure behaves like a CLOS class which:

e Hasaninitform of ni | for each dot.
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Has the keyword version of the slot name as initarg for each slot.
» Has only singleinheritance.

» Has no methods defined on it.

* Should not be modified from Lisp after its creation.

A KnowledgeWorks structure is defined by the macro:

(def-kb-struct <cl ass-spec> <sl ot -spec>*)

where the arguments are the same as for def st r uct except that in <cl ass- spec> only the options: i ncl ude and
cprint-functionarealowed. A structure may only be included in a KnowledgeWorks structureif it tooisa
KnowledgeWorks structure defined by def - kb- st r uct . All the functions normally provided by def st r uct (accessors, a
predicate etc.) are generated. An instance of the structure class may be created by the generic function:

(make-i nstance <cl ass-nane>
{<sl ot -speci fier> <val ue>}*)

where <sl ot - speci fi er > isthe keyword version of the slot name, as with any structures, and <val ue> isthe value the
slot isto take, otherwise defaulting to the value specified in the def - kb- st ruct form. If created from Lisp by any means
other than nake- i nst ance (for example, by the automatically defined nake- <st r uct ur e- name> constructor), the
inference engine will not know about the structure.

Once created, structures must not be modified directly from Lisp as thiswill corrupt the state of the forward chaining
inference engine. For example:

(def-kb-struct train position speed)

(def -kb-struct signal position color)
(make-instance '"train :position O :speed 80)
(make-instance 'signal :position 10 :color 'red)

defines KnowledgeWorks structures for trains and signals and makes an instance of each. Note that they are not fully-fledged
CLOS abjects but are analogous to working memory elements in OPS5.

6.2.1.2 Efficient Forward Chaining Rule Preconditions

Forward chaining rules are more efficient if the more restrictive preconditions (that is, the ones which will have fewer
matches) are written first. Computationally cheap Lisp tests should be used wherever possible as they reduce the search space
of the rule interpreter. The Lisp tests should where possible be broken into sufficiently small pieces that they can be applied
as early on as possible.

For example, the precondition fragment:

(train ?t position ?pl)
(test (> ?pl 5))
(signal ?s position ?p2)
(test (> ?p2 6))

is better than:

(train ?t position ?pl)
(signal ?s position ?p2)
(test (and (> ?pl 5) (> ?p2 5)))

because in the first example the Lisp tests can be applied directly to the trains and signals respectively before looking at
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combinations of trains and signals, whereas in the second case all the combinations must be produced before the Lisp test can
be applied. Simply separating the tests is enough for the rule compiler to apply them to the right object base matches — the
precise order of the tests is unimportant.

6.2.1.3 Profiling

You can use the profiler to profile forward chaining rules. Seeset - up- profi | er inthe LispWorks® User Guide and
Reference Manual.

6.2.2 Conflict Resolution

6.2.2.1 Use of Contexts

The single most significant way to improve conflict resolution timeis to divide the rulebase up into contexts. The time taken
by conflict resolution is dependent on the total number of instantiations of al the rules in the context so the fewer rulesin
each context, the more efficient conflict resolution will be.

6.2.2.2 Optimization of the Strategy

A conflict resolution strategy may be optimized by combining the constituent tactics in a more effective manner. There are
three different types of conflict resolution tactic:

* Rule-defined (meaning the tactic relies only on the rule of the instantiation and on nothing else), including priority,
-priority,order,-order,specificityand-specificity.

+ Static (meaning the tactic does not ook into the slots of the matched objects which make up the instantiation), including
recency and-recency.

» Dynamic (meaning the tactic may look into the objects making up the instantiation), including nea, - nea, | ex and
-l ex.

KnowledgeWorks is best able to optimize rule-defined tactics and | east able to optimize dynamic tactics. The optimizations
for a particular type of tactic can only be applied if it is preceded only by tactics which can be optimized to the same degree
(or better). For example, inthe strategy (recency priority), thetacticpri ority would only be optimized as a static

tactic. Inthestrategy (priority nmea recency), priority canbeoptimized as arule-defined tactic but r ecency will
be treated as a dynamic tactic.

Some final points to bear in mind:

» Tacticswhich tend to prefer existing instantiations over newer ones (for example - nea, - | ex and - r ecency) will
degrade performance.

* recency and| ex have similar functionality but r ecency is more efficient.

6.2.3 Backward Chaining

6.2.3.1 Pattern Matching

The KnowledgeWorks Backward Chainer indexes clauses for a backward rule based on the first argument. If the first
arguments to backward rule clauses are distinct non-variables, the backward chainer can pre-select possible matching clauses
foracall.

For example, in the following rule:
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(defrul e age-of :backward
((age-of charlie 30) <--)
((age-of william 25) <--)
((age-of james 28) <--))

Thecal: (age-of james ?x) would jump directly to the third clause and bind ?x to 28 without trying the other two.
Thecall: (age-of tom ?x) would fail immediately without doing any pattern matching.

Clauses are distinguished first by the types and then the values of their first arguments.

6.2.3.2 Tail Recursion

The KnowledgeWorks Backward Chainer supports the transformation of "tail-recursive" callsinto jumps. Thus, stack
overflow can be avoided without resorting to "repeat, fail" loops in most cases. For example, given the definition:

(defrul e run-forever :backward
((run-forever)
<- -

(run-forever)))

thecal: (run-forever) will runforever without generating a stack overflow. Note that this optimization is not limited to
recursive callsto the same rule. Thelast call of any rule will be compiled as ajump, drastically reducing stack usage.

6.2.3.3 Cut

The use of "cut" isawell known performance enhancement for Prolog-style rules. In KnowledgeWorks it does more than
reduce the time spent in search. When a"cut” isinvoked, all the stack space between the initial call to the containing rule and
the current stack location is reclaimed immediately, and can have a significant impact on the total space requirements of a
program.

6.3 Use of Meta-Classes

Objects of meta-classes other than st andar d- cl ass may be made available to KnowledgeWorks by including the
KnowledgeWorks mixin st andar d- kb- obj ect . Thisrequires:

» Theexistence of aval i dat e- super cl ass method alowing st andar d- kb- obj ect (meta-classst andar d- cl ass)
to be a superclass of the class being defined with a different meta-class.

» That the meta-classin question does not implement any particularly strange behavior on dot access, for example, if
guerying aslot value resultsin setting it.

6.3.1 Example

A meta-class st andar d- kb- cl ass could be defined as a KnowledgeWorks class. New KnowledgeWorks classes (or even
ordinary non-KnowledgeWorks classes) could be defined with this meta-class. KnowledgeWorks could then reason about the
instances of the classes and about the class objects themselves. The code below implements this:

(def -kb-cl ass standard-kb-cl ass (standard-class) ())
(def met hod val i dat e- supercl ass
((cl ass standard-kb-cl ass)
(supercl ass standard-cl ass))
t)
(def-kb-class foo () ((slot))
(: netacl ass standard-kb-cl ass))
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Then when the following rulefires:

(defrule find-kb-class :forward
(standard- kb-class ? clos::name ?n)
-->
((format t "~% can reason about class ~s" ?n)))

it will output:

I can reason about class FOO

6.4 Logical Dependencies and Truth Maintenance

When arule creates an object that depends on a specific set of preconditions, it is sometimes necessary to erase that object
when those preconditions no longer hold. Thisisan example of truth maintenance.

KnowledgeWorks provides a mechanism to track logical dependencies between objects and preconditions which cause any
dependent objects to be erased automatically. Thisis achieved using al ogi cal clausein aforward chaining rule, with a
precondition of the form:

(1 ogi cal <forward-condition>+)

The enclosed forward conditionsin this clause are matched as normal, but if the rule fires and creates new objects (by

assert or make- i nst ance) then these objects are associated with the enclosed conditions. If the conditions are found to be

false in the future, then the created objects are erased automatically (seeer ase).

NB: There can be at most onel ogi cal clausein arule (though it can contain multiple subclauses) and it must be the first
clausein therule. Other clauses can follow the logical clause, but they are not part of the logical dependency.

6.4.1 Example

Given the following classes and rules:

(def - kb-cl ass nunber-obj ect ()
((value :initarg :value)))

(def -kb-cl ass have-sone- | arge- nunbers ()

)

(defrul e notice-a-1arge-nunber :forward
(1 ogi cal (nunber-object ? value ?val ue)
(test (> ?value 100)))
-->
(assert (have-sone-|arge-nunbers ?)))

then ahave- sone- | ar ge- nunber s object will be created when a number larger than 100 exists:

(setq nl (meke-instance 'nunber-object :value 10))
(infer)

(any '?x ' (have-some-I|arge-nunbers ?x)) ==> fal se
(setf (slot-value nl 'value) 200) ; this is large
(infer)

(any ' ?x ' (have-sone-| arge-nunbers ?x)) ==> true

In addition, when the large number becomes smaller, the have- sone- | ar ge- nunber s object will be erased again:
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(setf (slot-value nl 'value) 55)
(infer)
(any '?x '(have-sone-|arge-nunbers ?x)) ==> fal se

because alogical dependency was tracked between the preconditions:

(nunber -obj ect ? val ue ?val ue)
(test (> ?val ue 100)

and the have- sone- | ar ge- nunber s object.

6.5 Inferencing States

An inferencing state represents al the state needed to run the forward chaining interpreter, including the object base, the
current cycle number and the set of unfired instantiations. It does not include rule or context definitions or any backward
chaining state information.

6.5.1 Creating and Maintaining Inferencing States

Inferencing states are first-class objects that can be created and destroyed as required. Each inferencing state must have a
unique name (as compared with eql ) and initially there is asingle inferencing state named : def aul t .

The function make- i nf er enci ng- st at e makes anew empty inferencing state. Inferencing states must be destroyed with
dest roy-i nf er enci ng- st at e when no longer needed, to release the memory that they use.

Inferencing states can be found using the function f i nd- i nf er enci ng- st at e and the function
li st-all-inferencing-states canbeusedto make alist of al known inferencing states.

6.5.2 The Current Inferencing State

The value of the variable *i nf er enci ng- st at e* isknown as the current inferencing state. Its value can be changed before
calling KnowledgeWorks functions, but should not be changed within the body of arule.

Some operations, such as object creation, slot modification, r eset andi nf er only affect the current inferencing state.
Backward chaining operations that match the object base only find objects from the current inferencing state.

Operations that change rules or contexts, such asdef rul e and cl ear - al | , affect al inferencing states.

6.5.3 Uses of Inferencing States

In many cases, a single inferencing state is sufficient and the initial inferencing state named : def aul t can be used without
any special effort.

To alow severa independent inferencing operations to be performed simultaneously, multiple inferencing states must be
managed explicitly. Sometypical situations are described below.

6.5.3.1 Multiple threads

By binding *i nf er enci ng- st at e* around all KnowledgeWorks operations in athread's main function as in the example
below, its value can be unique to each thread.

(defun test-1-counter (name)
(let* ((*inferencing-state* nil)
(step (1+ (random 10)))
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(limt (* step (+ 2000 (random 100)))))
(unwi nd- prot ect
(progn
(setqg *inferencing-state*
(make-i nferenci ng-state nane))
(make-instance ' counter
cvalue limt

. step step)
(infer))
(destroy-inferencing-state *inferencing-state*))))
(np: process-run-function (format nil "Test ~D' index)
()
"test-1-counter
(gensym

6.5.3.2 Interleaved in a Single Thread

By binding *i nf er enci ng- st at e* around specific KnowledgeWorks operations in a function as in the example below,
multiple inferencing states can be maintained within a single thread.

(defun test-stepping-single-context ()
(let ((statel (make-inferencing-state 'statel))
(state2 (make-inferencing-state 'state2)))
(unwi nd- pr ot ect
(progn
(let ((*inferencing-state* statel))
(make-instance 'step-controller
: kb- nanme ' st epper-one-a))
(let ((*inferencing-state* state2))
(make-instance 'step-controller
: kb- nanme ' st epper-one-b))
(1 oop repeat 10
do
(let ((*inferencing-state* statel))
(infer))
(let ((*inferencing-state* state2))
(infer))))
(destroy-inferencing-state statel)
(destroy-inferencing-state state2))))
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The symbols documented in the following pages are all external in the KW package unless stated otherwise. They are listed
in alphabetical order.

all-debug Function

Summary

Turns debugging facilities on.

Package

kw

Signature

al | - debug

Description

Thefunction al | - debug turns on all KnowledgeWorks debugging facilities. This means that rules and contexts can be
single stepped and monitored, and arecord is kept of whenever objects are created or modified.

This should be called before compiling any rules or contexts that are to be debugged.

Examples

(al I - debug)

See also

no- debug

any Function

Summary

Return the first match of a backward chaining goal.

Package

kw
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Signature

any pattern-to-instantiate goal-to-prove => result, successp

Arguments

patter n-to-instantiatel]

A list or symbol.
goa] _to_proveD Any backward chaini ng goal .
Values
result ni | or avalue matching patter n-to-instantiate.
successp A boolean.
Description

The function any starts the backward chaining inference engine to look for any set of bindings which satisfy goal-to-prove.
Using those bindings, pattern-to-instantiate isinstantiated and returned.

Two values are returned. The second value indicates with t that a proof was found, or with ni | that no proof exists. In the
former case, thefirst value is the instantiated version of pattern-to-instantiate, in the latter case, the first valueisni | .

Any subgoal s that match the object base will only find objects from the current inferencing state.
Examples

(any " (?x is in (12 3)) '(menber ?x (1 2 3)))
returns(1 IS IN (1 2 3)), T.

(any '(?truck is a truck) '(truck ?truck))

returns (#<TRUCK TRUCK5> | S A TRUCK), T.

See also

findal |

assert Backward Chaining Goal

Summary

Creates or modifies objects in the object base.

Package

kw

Signature

assert (classname variable {slot-and-term} *)
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dot-and-term : : = (slot-name term)

Arguments

class-name] The name of aclass.

variablel] A variable beginning with 2.
dot-named The name of adot in class-name.
term An expression.

Description

The backward chaining goal assert creates or modifies objects in the object base.

class-name must be the name of a class of objects known to KnowledgeWorks. Each termis an expression composed of Lisp
data structures and KnowledgeWorks variables.

If variable is unbound a new instance of class-name is created with each named slot-name initialized to the value of the
corresponding term.

If variable is bound, that bound instance has its named slots modified to contain the values of term corresponding to each slot
-name. It isan error if the bound object is not of the named class.

It isan error to put an unbound variable into aslot of an object in the object base.

Only objectsin the current inferencing state will be affected.

Examples

(assert (truck ?truck driver ?driver))
(assert (possible-trucks ? trucks (?truck . ?trucks))

See also

erase

clear-all Function

Summary

Clears all contexts, rules and objects.

Package

kw

Signature

clear-all

Description

Thefunction cl ear - al | clearsall contexts, rules and objects. Thelist of KnowledgeWorks classes remains unaffected. The
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default context def aul t - cont ext isnot removed, but al rulesinit are.

The function affects al inferencing states.

Examples

(clear-all)

See also

clear-rul es
reset

clear-rules Function

Summary

Clears all contexts and rules.

Package

kw

Signature

clear-rul es

Description

Thefunction cl ear - r ul es clears contexts and rules. The list of KnowledgeWorks classes and the object base remains
unaffected. The default context def aul t - cont ext isnot removed, but al rulesin it are.

This function affects all inferencing states.

Examples

(clear-rules)

See also

cl ear - al
r eset

conflict-set Backward Chaining Goal

Summary

Finds the current meta-interpreter rule instantiations.
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Package

kw

Signature

conflict-set variable

Arguments

variablel] An unbound KnowledgeWorks variable introduced by ?.

Description

The backward chaining goal confl i ct - set isonly relevant when writing a meta-interpreter for a context. conf | i ct - set
binds variable to thelist of al existing rule instantiations in the currently executing context. Thislist isin the order preferred

by the conflict resolution strategy for the context.

Examples

(conflict-set ?conflict-set)

See also

instantiation
fire-rule

context

Summary

Adds new contexts to the agenda.

Package

kw

Signature

cont ext context-list

Arguments

context-list(] A list of context names.

Description

Backward Chaining Goal

The backward chaining goal cont ext adds new contexts context-list on top of the agenda (the context stack). The current

context is not changed. Itisan error if the named contexts do not exist.

If context-list contains variables, then they must be already bound.
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Examples

(context (ny-context))
(context (?x ?y)) ; if ?x ?y bound to context nanes

See also

return

current-cycle Function

Summary

Returns the current forward chaining cycle number.

Package

kw

Signature

current-cycl e => cycle-number

Values

cycle-number Aninteger.

Description

The function cur r ent - cycl e returns the current cycle number of the forward chaining rule interpreter in the current
inferencing state. If the forward chaining rule interpreter is not running, then it returns the total number of cycles executed by
the forward chaining rule interpreter the last time it ran. If the forward chaining rule interpreter has not run at all, then it
return zero.

See also

*i nf erenci ng- st at e*

cut Backward Chaining Goal

Summary

The standard prolog predicate that stops backtracking.

Package

kw

Signature

cut
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Description

The backward chaining goal cut isastandard prolog predicate. When first called it succeeds and freezes certain choices
made by the backward chainer up to this point. It may no longer attempt to resatisfy any of the goals between the start of
clause and the cut , and it may not attempt to use any other clauses to satisfy the same goal.

Examples

(defrul e nice :backward
((nice ?x)
<- -
(rottweiler ?x)
(cut)
(fail))

((nice ?x) <--))

implements "everything isnice unless it is arottweiler". First the backward chainer will attempt to prove (ni ce fi do) with
thefirst clause. If fi do isarottweiler the cut then prevents the backward chainer from using the second clause which says
"everything isnice". Thefail ensuresthat (ni ce fi do) fails.

See also

fail

*cycle* Symbol Macro

Summary

Deprecated.

Package

kw

Description

The symbol macro *cycl e* isdeprecated. New code should usecur r ent - cycl e.

Prior to LispWorks 5.0, *cycl e* wasavariable.

See also

current-cycle

defcontext Macro

Summary

Defines a context.
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Package

kw

Signature

def cont ext context-name &key refractoriness auto-return strategy meta documentation

Arguments

context-name] The name of the context being defined.
refractorinessl] A boolean.

auto-returnC] A boolean.

strategy(] A list of symbols.

metal] A list of actions.

documentation] A string.

Description

The macro def cont ext defines a context named context-name. If a context of that name aready existsthen it, and al the
rulesinit, arefirst removed.

If refractorinessisni | then arule instantiation remains eligible to fire again after firing once. If refractorinessist (the
default) then each rule instantiation will only fire once.

auto-return indicates, when there are no more rules to be fired in the context, whether to signal an error or simply to pass
control to the next context on the agenda. The default valuet passes control on without an error.

strategy is the conflict resolution strategy for the context, consisting of alist of tactic names.
metaisalist of actions which make up the optional meta-interpreter for the context.

If documentation is supplied, then it should be a string. The value can be retrieved by calling the function docunent at i on

with doc-type cont ext .

Examples

(defcontext my-context :strategy (priority recency))
(defcontext another-context :strategy (order)
:meta ((start-cycle)
(instantiation ?inst)
(fire-rule)
(cut)
(anot her-context)))

See also

standar d-context
-l ex

Lex

- mea

nea

- order

or der
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-priority
priority
-recency
recency
-specificity
specificity

def-kb-class Macro

Summary

Defines aclass for use in the object base.

Package

kw

Signature

def - kb- cl ass class-name superclass-list slot-descriptions & est options => class

Arguments

class-nameld A symbol.

superclass-listd] A list of symbols.

slot-descriptionsC] A list of def cl ass slot descriptions.
optionsl] def cl ass options.

Values

class The named class object.
Description

The macro def - kb- cl ass defines anew CLOS class name class-name, asdef cl ass does. However, if none of the
superclasses in superclass-list isa subclass of st andar d- kb- obj ect , then st andar d- kb- obj ect isadded to thelist of
superclasses.

slot-descriptions and options are used as in the standard def cl ass macro.

Examples

(def-kb-class vehicle () ((driver :initarg :driver)))
(def-kb-class truck (vehicle)
((load :accessor truck-1oad)))

See also

def - naned- kb- cl ass
def - kb- st ruct
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def-kb-struct Macro

Summary

Defines a structure class for use in the object base.

Package

kw

Signature

def - kb- struct name-and-options { dot-description} * => name

name-and-options : : = name | (name { option} *)

option ::= (:include superclass) | (:print-function print-function)
Arguments

slot-descriptionC] A def st ruct dot description.

namel] A Symb0|

superclassl] A symbol.

print-functionC A symbol or alambda expression.

Values

name The name of the structure class.

Description

The macro def - kb- st ruct defines a KnowledgeWorks structure class name name. Objects of these classes are analogous
to Lisp structures except that they may be used in rules similarly to CLOS objects.

If superclassis supplied then name will inherit from superclass, which must be KnowledgeWorks structure class.

print-function and slot-description are used asin def st r uct .

Examples

(def -kb-struct start)

(def -kb-struct (naned-kb-struct
(:print-function print-nanmed-kb-struct))
(nanme (gensym ' naned-kb-struct)))

(def -kb-struct (possible-trucks-for-Ioad
(:include named-kb-struct))
| oad trucks)
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See also

def - kb-cl ass

def-named-kb-class Macro

Summary

Defines a class of named objects for use in the object base.

Package

kw

Signature

def - naned- kb- cl ass class-name superclass-list slot-descriptions & est options => class

Arguments

class-nameld A symbol.

superclass-list] A list of symbols.

slot-descriptionsC] A list of def cl ass slot descriptions.
options] def cl ass options.

Values

class The named class object.
Description

The macro def - naned- kb- cl ass defines anew CLOS class name class-name, asdef cl ass does. However, if none of the
superclasses in superclass-list is a subclass of naned- kb- obj ect , then naned- kb- obj ect isadded to thelist of
superclasses. The class inherits aname slot called kb- nane, with accessor kb- nane and default initialization form

(:i ni tf or m) that generates a symbol from the class name using ( gent enp class-name) .

slot-descriptions and options are used as in the standard def cl ass macro.

Examples

(def - named- kb-cl ass vehicle ()
((driver :initarg :driver)))

(def - named- kb-cl ass truck (vehicle)
((load :accessor truck-1oad)))

See also

def - kb-cl ass
def - kb- struct
get - kb- obj ect
kb- nane

naned- kb- obj ect
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defrule Macro

Summary

Definesarule.

Package

kw

Signature

defrul e rulename direction &opti onal doc-string &ody body => rule-name

Arguments

rule-namel] A symbol.

directiond Either : f orwar d or : backwar d.
doc-string An optional string.

body[] Forms as described in 3 Rules.
Values

rule-name A symbol.

Description

The macro def r ul e defines arule named rule-name (which must be distinct from any other rule name, context name or
KnowledgeWorks class name). If directionis: f or war d aforward chaining ruleis defined, if : backwar d a backward
chaining rule is defined. If doc-string is given, then it should be a string. The value can be retrieved by calling the function
docunent at i on with doc-typer ul e.

A full description of body is givenin 3 Rules.

Examples

(defrule nove-train :forward :context trains
(train ?train position ?train-pos)
(signal ?signal position ?signal-pos color green)
(test (= 7?signal-pos (1+ ?train-pos)))
-
((format t "~%rain noving to ~S" ?signal - pos))
(assert (signal 7?signal color red))
(assert (train ?train position ?signal-pos)))
(defrule link-exists :backward
((l'ink-exists ?townl ?town2)
<- -
(or (link ?link towmnl ?townl town2 ?town2)
(link ?link town2 ?townl townl ?town2))

(cut))
((l'ink-exists ?townl ?town2)
<- -

(route-exists ?townl ?town2)))
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deftactic Macro

Summary

Defines atactic function for use in context strategies.

Package

kw

Signature

deftacti c tacticname type lambda-list &ody body => tactic-name

Arguments

tactic-namel] A symbol.

typel] Either : static or: dynani c.
lambda-list[] A two argument lambda list.
body] A function body.

Values

tactic-name A symbol.

Description

Themacro def t act i ¢ defines anew conflict resolution tactic named tactic-name.

type is the type of the tactic, which may be: st at i ¢ if body does not look into the slots of the objects making up the
instantiation, otherwise : dynami c.

lambda-list specifies two variable, which will be bound to two instantiation objects and when the forms of body are
evaluated. body should return non-nil if and only if the first instantiation object is preferred to the second.

deftacti ¢ aso defines afunction named tactic-name and body can be preceded by a documentation string.

The newly defined tactic may be used as any in-built tactic.

Examples

(deftactic prefer-trucks :static (instl inst2)
(flet ((truck-p (obj) (typep obj '"truck)))
(and (sonme # truck-p (inst-token instl))

(notany #'truck-p (inst-token inst2)))))

The new tactic may be used in adef cont ext form:

(defcontext my-context :strategy (prefer-trucks))
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See also

i nst-bi ndi ngs
i nst-token
i nst-rul enane
def cont ext

destroy-inferencing-state

Summary

Destroys an inferencing state.

Package

kw

Signature

destroy-i nferenci ng-state nameor-state

Arguments

name-or-statel] Any object.

Description

The function dest r oy- i nf er enci ng- st at e destroys an inferencing state named by name-or-state.

Function

If name-or-state is and inferencing state, then it is destroyed. Otherwise, any inferencing state with that name (as compared

using eql ) is destroyed.

It isan error to destroy the current inferencing state.

Examples

(destroy-inferencing-state 'ny-state)

See also

find-inferencing-state

*i nf erenci ng- st at e*

i nf erenci ng- st at e- nane
list-all-inferencing-states
nmake- i nf erenci ng-state
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erase

Summary

Erases an object from the object base.

Package

kw

Signature

erase variable

Arguments

variable] A aKnowledgeWorks object.

Description

The backward chaining goal er ase erases an object from the object base.
variable must be bound to a KnowledgeWorks CLOS object or a KnowledgeWorks structure.

The given object is removed from the object base of the current inferencing state.

Examples

(erase ?x) ; ?x bound to an object

See also

assert

fail

Summary

The standard prolog predicate that always fails.

Package

kw

Signature

fail

73
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Description

The backward chaining goal f ai | awaysfails. It is sometimes used with cut.

Examples

(defrul e nice :backward
((nice ?x)
<- -
(rottweiler ?x)
(cut)
(fail))

((nice ?x) <--))

implements "everything isnice unless it is arottweiler”.

See also

cut

findall
findallset

Summary

Return all matches of a backward chaining goal.

Package

kw

Signatures

findal | pattern-to-instantiate goal-to-prove => list
findal | set pattern-to-instantiate goal-to-prove => set
Arguments

patter n-to-instantiatel]

A list or symbol.
goa] _to_proveD Any backward chaini ng goal
Values
list A list.
set[] A list.
Description

Functions

Thefunction fi ndal | startsthe backward chaining inference engine to look for al sets of bindings which satisfy goal-to-
prove. For each of those bindings, pattern-to-instantiate isinstantiated and collected to return alist. Thevaueisni | if
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nothing goal-to-prove cannot be satisfied.
Any subgoal s that match the object base will only find objects from the current inferencing state.
Thefunctionfi ndal | set islikefi ndal | but set will not have any duplicates (as compared by equal ).
Examples

(findall "(?x is in (12 3)) '(menber ?x (1 2 3)))
returns:

((L1SIN(1 2 3))
(2 1SIN(1 2 3))
(31SIN(1 2 3)))

(findall '"(?truck is a truck) '(truck ?truck))

returns:

((#<TRUCK TRUCK1> 1S A TRUCK)
(#<TRUCK TRUCK2> | S A TRUCK))

See also

any

find-inferencing-state Function

Summary

Finds a known inferencing state.

Package

kw

Signature

find-inferencing-state name &ey if-does-not-exist => state

Arguments

name’] Any object.
if-does-not-exist[] Either : error or:create.
Values

state An inferencing state.
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Description

Thefunction f i nd- i nf er enci ng- st at e finds and returns an inferencing state named by name.

If an inferencing state with the same name already exists (as compared using eql ), it isreturned.

Otherwise, the value of if-does-not-exist determines what happens:

serror A continuable error issignaled. Invoking the cont i nue restart creates and returns a new
inferencing state.

:create A new inferencing stateis created and returned.

Examples

(find-inferencing-state 'my-state)

See also

destroy-inferencing-state
*i nf erenci ng- st at e*

i nf erenci ng-st at e- nane
list-all-inferencing-states
meke-i nf erenci ng-state

fire-rule

Summary

Fires the given meta-interpreter rule instantiation.

Package

kw

Signature

fire-rul e instantiation

Arguments

instantiation An instantiation object.

Description

Backward Chaining Goal

The backward chaining goal f i r e-r ul e isonly relevant when writing a meta-interpreter for acontext. fire-rul e firesthe
given rule instantiation instantiation. It isan error if the passed object is not an instantiation object.

Examples

(fire-rule ?instantiation)
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See also

start-cycle
instantiation

def cont ext
standar d-context

get-kb-object Function

Summary

Finds a named object in the object base.

Package

kw

Signature

get - kb- obj ect object-name => object

Arguments

object-namel] A symbol.

Values

object A KnowledgeWorks CLOS object.
Description

The function get - kb- obj ect returns the KnowledgeWorks object named object-name in the object base of the current
inferencing state. If there is no such object an error results.

Classes of named objects can be defined using the macro def - nanmed- kb- cl ass.

Examples

(get-kb-object 'fred)

See also

def - naned- kb- cl ass
kb- name
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infer Function

Summary

Runs the forward chaining inferencing engine.

Package

kw

Signature

i nfer &key contexts => cycle-count

Arguments

contexts[] A list of context names, default to (def aul t - cont ext).
Values

cycle-count] An integer.

Description

Thefunctioni nf er runsthe forward chaining inference engine in the current inferencing state, with contexts as the initial
agenda. Thefirst rulesto fire will be from the first context listed in contexts until control is passed on.

The value returned as cycle-count is the total number of cycles executed (givenincurrent - cycl e).

Examples

(infer :contexts '(ny-context another-context))

See also

current-cycle

*inferencing-state* Variable

Summary

The current inferencing state.

Package

kw

Initial Value
An empty inferencing state named : def aul t .
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Description

The value of the variable *i nf er enci ng- st at e* isthe current inferencing state for many KnowledgeWorks functions.

This variable can be bound to a particular inferencing state before calling other KnowledgeWorks functions, but should not be

changed within the body of arule.

See also

current-cycle
destroy-inferencing-state
find-inferencing-state

i nf erenci ng- st ate-nane
list-all-inferencing-states
make- i nf erenci ng-state

inferencing-state-name

Summary

Returns the name of an inferencing state.

Package

kw

Signature

i nf erenci ng- st at e- nane state => name

Arguments

stated Aninferencing state.
Values

name Any object.
Description

Thefunctioni nf er enci ng- st at e- nane returns the name of state.

Examples

(i nferenci ng-state-nane *inferenci ng-state*)

See also

find-inferencing-state

*i nf erenci ng- st at e*
list-all-inferencing-states
nmake- i nf erenci ng-state
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*in-interpreter* Variable

Summary

Allows code to detect when it isrunning in arule.

Package

kw

Initial Value
nil
Description

Thevariable*i n-i nterpreter* isboundtot if the code executing has been called (directly or indirectly) from the
forward chaining rule interpreter. Otherwise it bound to ni | . The value should not be changed.

instantiation Backward Chaining Goal

Summary

Find the next meta-interpreter rule instantiation that will fire.

Package

kw

Signature

instanti ati on variable

Arguments

variable] An unbound variable introduced by ?.

Description

The backward chaining goal i nst ant i at i on isonly relevant when writing a meta-interpreter for a context.
i nstanti ati on binds variableto the next preferred instantiation from the conflict set of the currently executing context.

This goal may be satisfied repeatedly each time returning the next instantiation. When no instantiations are lft, it fails.

Examples

(instantiation ?instantiation)
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See also

conflict-set

i nst-bi ndi ngs
i nst-rul enane
i nst-token
start-cycle
fire-rule

def cont ext
standar d-context

inst-bindings Function

Summary

Returns the bindingsin arule instantiation.

Package

kw

Signature

i nst - bi ndi ngs instantiation => bindings

Arguments

instantiationd An instantiation object.
Values

bindings An association list.
Description

The functioni nst - bi ndi ngs returns an association list of the variables and their bindingsin instantiation. The variables
are those produced by the condition part of the forward chaining rule.

Examples
For an instantiation of a rule with the precondition:
(object ? color ?col or-value size ?size)
the value returned by:
(i nst-bindings inst)
might be:

((?color-value . :red) (?size . 20))
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See also

conflict-set
deftactic

i nst-rul enane
i nst-token
instantiation

inst-rulename

Summary

Returns the rule name of arule instantiation.

Package

kw

Signature

i nst -rul enane instantiation => rulename

Arguments

instantiationd An instantiation object.

Values

rulename A symbol which isthe name of arule.
Description

Function

Thefunctioni nst - r ul enane returns the rule name of instantiation (the name of the rule of which thisis an instantiation).

See also

conflict-set

i nst-bi ndi ngs
deftactic

i nst-token
instantiation

inst-token

Summary

Returns the token of arule instantiation.

Package

kw

82
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Signature

i nst -t oken instantiation => token

Arguments

instantiation] An instantiation object.
Values

tokenO A list of objects.
Description

Thefunctioni nst - t oken returns the token of instantiation. token isthe list of objects that match the condition part of the
forward chaining rule. Thislist of objectsisin reverse order to the order in which the conditions appear in the rule.

Examples

If the forward chaining conditions are:

(train ?train)
(signal ?signal)

then the token will have the form ( signal-object train-object) .

See also

conflict-set
deftactic

i nst-rul enane
i nst-bi ndi ngs
instantiation

kb-name

Summary

Returns the name of an object.

Package

kw

Signature

kb- nane object => name

Arguments

object A KnowledgeWorks named CL OS object.
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Values

name A symbol.

Description

The generic function kb- name returns the name of object. It isan error if object is not anamed object. Classes of named

objects can be defined using the macro def - naned- kb- cl ass.

Examples

(kb-nane (get-kb-object 'fred))

See also

def - naned- kb- cl ass
get - kb- obj ect
naned- kb- obj ect

kw-class

Summary

Matches all KnowledgeWorks class names.

Package

kw

Signature

kwcl ass term

Arguments

returns FRED

termd Any backward chaining term.

Description

Backward Chaining Goal

The backward chaining goal kw- cl ass matches all KnowledgeWorks class names. It can act as a generator and can be
resatisfied. It succeeds when termis asymbol which is the name of a KnowledgeWorks class. If termisan unbound variable
it generates the names of the KnowledgeWorks classes.

Examples

(kw-class truck) ; succeeds if truck is a KWcl ass

(kwcl ass ?cl ass)

; ?class is bound to the nanme of a KWcl ass
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See also

def - kb-cl ass
def - kb- st ruct
def - naned- kb- cl ass

lex

Summary

Implementsthel ex tactic.

Package

kw

Signature

| ex instantiationl instantiation2 => result

Arguments

instantiation10 An instantiation object.
instantiation2] An instantiation object.
Values

result A boolean.
Description

Conflict Resolution Tactic / Function

The conflict resolution tactic / function | ex implements the LEX tactic. It returnstrueif and only if instantiationl is
preferred to instantiation2 by the conflict resolution tactic | ex, otherwise false. The function is intended to be used primarily
by including it in the conflict resolution strategy for a context.

Examples

(def context ny-contextl :strategy (lex))

(def context ny-context2 :strategy (priority |lex))

See also

3.1.5.3 Conflict Resolution
def cont ext

deftactic

-1 ex

instantiation

conflict-set

fire-rule

85



7 Reference Guide

-lex

Summary

Implementsthe - | ex tactic.

Package

kw

Signature

- | ex instantiationl instantiation2 => result

Arguments

instantiation10 An instantiation object.
instantiation2] An instantiation object.
Values

result A boolean.
Description

Conflict Resolution Tactic / Function

The conflict resolution tactic / function - | ex returnstrueif and only if instantiationl is preferred to instantiation2 by the
conflict resolution tactic -| ex, otherwise false. The function isintended to be used primarily by including it in the conflict

resolution strategy for a context.

Examples

(def context ny-contextl :strategy (-lex))
(def context ny-context2 :strategy (priority -lex))

See also

3.1.5.3 Conflict Resolution
def cont ext

deftactic

I ex

instantiation

conflict-set

fire-rule
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list-all-inferencing-states

Summary

Returns alist of al the known inferencing states.

Package

kw

Signature

list-all-inferencing-states => states

Values

states A ligt of inferencing states.

Description

Function

Thefunctionl i st-all-inferencing-states returnsalist of al the known inferencing states. Inferencing states become

known when they are make and are known until they are destroyed.

Examples

(list-all-inferencing-states)

See also

destroy-inferencing-state
find-inferencing-state

*i nf erenci ng- st at e*

i nf erenci ng- st at e- nane
nmake- i nf erenci ng-state

make-inferencing-state

Summary

Makes a new inferencing state.

Package

kw

Signature

make- i nf erenci ng- st at e name &key set-current-p if-exists => dtate
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Arguments

namel] Any object.

set-current-pQ] A boolean.

if-exists] Either : error, : supersede or: overwite.
Values

state Aninferencing state.

Description

The function make- i nf er enci ng- st at e returns an inferencing state named by name.

If an inferencing state with the same name already exists (as compared using eql ), then the value of if-exists determines what
happens:

serror A continuable error issignaled. Invoking the cont i nue restart causes the existing inferencing
state to be returned.

: super sede The existing inferencing state is destroyed and a new oneis returned.

joverwite The existing inferencing state is returned.

If set-current-p is non-nil, then *i nf er enci ng- st at e* is set to new inferencing state.

Examples

(make-inferencing-state 'my-state)

See also

destroy-inferencing-state
find-inferencing-state

*i nf erenci ng-st at e*

i nf erenci ng-st at e- nane
list-all-inferencing-states

make-instance Generic Function

Summary

Makes a CLOS or KnowledgeWorks structure object.

Package

common-|isp

Signature

make- i nstance class & est initargs => object
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Arguments

class[] A class object or asymbol.

initargsl] Initialization arguments for the object.
Values

object A new instance of class.
Description

The generic function make- i nst ance makes a new instance of the class class.

If classis a CLOS class then the behavior is as specified by make-instance in the Common Lisp standard.

If classis a KnowledgeWorks structure class, then initargs are the same as those for the automatically defined constructor

function of the structure.

The object is added to the object base of the current inferencing state.

Examples

(rmake-instance 'start)
(make-instance 'driver :location 'London
:kb-nane 'fred)

See also
def - kb-cl ass

def - kb- st ruct
def - naned- kb- cl ass

mea

Summary

Implements the nea tactic.

Package

kw

Signature

nmea instantiationl instantiation2 => result

Arguments
instantiation1 An instantiation object.
instantiation2] An instantiation object.

89

Conflict Resolution Tactic / Function


http://www.lispworks.com/documentation/HyperSpec/Body/f_mk_ins.htm

7 Reference Guide

Values

result A boolean.

Description

The conflict resolution tactic / function mea returnstrue if and only if instantiationl is preferred to instantiation2 by the
conflict resolution tactic mea, otherwise false. The function isintended to be used primarily by including it in the conflict

resolution strategy for a context.

Examples

(def context ny-contextl :strategy (nea))
(defcontext my-context2 :strategy (priority mea))

See also

3.1.5.3 Conflict Resolution
def cont ext

deftactic

- nea

instantiation

conflict-set

fire-rule

-mea

Summary

Implements the - nea tactic.

Package

kw

Signature

- mea ingtantiationl instantiation2 => result

Arguments

instantiation10 An instantiation object.
instantiation20] An instantiation object.
Values

result A boolean.
Description

Conflict Resolution Tactic / Function

The conflict resolution tactic / function - mea returnstrue if and only if instantiationl is preferred to instantiation2 by the
conflict resolution tactic - mea, otherwise false. The function is intended to be used primarily by including it in the conflict
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resolution strategy for a context.

Examples

(defcontext my-contextl :strategy (-nea))
(defcontext my-context2 :strategy (priority -nea))

See also

3.1.5.3 Conflict Resolution
def cont ext

deftactic

nea

instantiation

conflict-set

fire-rule

named-kb-object

Summary

A classthat provides named objects.

Package

kw

Superclasses

st andar d- kb- obj ect

Initargs

Class

: kb- nane The name of the object. The default is computed by calling gent enp with the name of the

class.

Description

The class nanmed- kb- obj ect isthe mixin class for named KnowledgeWorks CL OS abjects.

Subclasses of named- kb- obj ect aretypically defined using the macro def - nanmed- kb- cl ass.

Examples

(defclass driver (naned-kb-object)
((location) (allocated-truck)))

See also

get - kb- obj ect

kb- nane

def - naned- kb-cl ass
st andar d- kb- obj ect
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no-debug Function

Summary

Turns debugging facilities off.

Package

kw

Signature

no- debug

Description

The function no- debug turns off all KnowledgeWorks debugging facilities. This means that rules and contexts cannot be
single stepped or monitored, and no record is kept of when objects are created or modified. Execution speed of the rulebaseis
improved, and memory requirements reduced.

This should be called before compiling any rules or contexts that are to be optimized.

Examples

(no-debug)

See also

al | - debug

not Backward Chaining Goal

Summary

A goal that is satisfied when another goal fails.

Package

kw

Signature

not { condition} *

Arguments

condition] Any backward chaining goal.
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Description

If the backward chaining goal not isused in abackward chaining clause, it succeedsif condition fails. In this usage, only

one condition is allowed.

If not isused in aforward chaining pre-condition, it succeeds if any condition contained within it fail. In this usage, each
condition may only contain expressions normally allowed in forward chaining pre-conditions (object base references and lisp

tests). See 3.1.2 Forward Chaining Syntax for more details.

Examples

(not (truck ?truck driver ?driver) (test ?2driver))

See also

test

order

Summary

Implements the or der tactic.

Package

kw

Signature

order instantiationl instantiation2 => result

Arguments

instantiation1 An instantiation object.
instantiation2] An instantiation object.
Values

result A boolean.
Description

Conflict Resolution Tactic / Function

The conflict resolution tactic / function or der returnstrueif and only if instantiationl is preferred to instantiation2 by the
conflict resolution tactic or der , otherwise false. The function isintended to be used primarily by including it in the conflict

resolution strategy for a context.

Examples

(defcontext my-contextl :strategy (order))
(defcontext my-context2 :strategy (priority order))
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See also

3.1.5.3 Conflict Resolution
def cont ext

deftactic

- order

instantiation

conflict-set

fire-rule

-order

Summary

Implements the - or der tactic.

Package

kw

Signature

-order instantiationl instantiation2 => result

Arguments

instantiation10 An instantiation object.
instantiation2] An instantiation object.
Values

result A boolean.
Description

Conflict Resolution Tactic / Function

The conflict resolution tactic / function - or der returnstrueif and only if instantiationl is preferred to instantiation2 by the
conflict resolution tactic - or der , otherwise false. The function isintended to be used primarily by including it in the conflict

resolution strategy for a context.

Examples

(def context ny-contextl :strategy (-order))
(def context ny-context2 :strategy (priority -order))

See also

3.1.5.3 Conflict Resolution
def cont ext

deftactic

or der

instantiation

conflict-set
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fire-rule

*print-verbose* Variable

Summary

Controls how much information is printed for an object.

Package

kw

Initial Value
ni |
Description

Thevariable* pri nt - ver bose* controls how much information is printed for an object.

Normally objects in KnowledgeWorks are printed out in a brief form similar to ordinary CLOS objects. If
*print-verbose* issettot then all the slots and slot values are shown in its printed representation. Note that circularities
cannot be detected.

priority Conflict Resolution Tactic / Function

Summary

Implementsthe pri ori ty tactic.

Package

kw

Signature

priority instantiationl instantiation2 => result

Arguments

instantiation10 An instantiation object.
instantiation2] An instantiation object.
Values

result A boolean.
Description

The conflict resolution tactic / function pri ori ty returnstrueif and only if instantiationl is preferred to instantiation2 by
the conflict resolution tactic pri ori t y, otherwise false. The function isintended to be used primarily by including it in the
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conflict resolution strategy for a context.

Examples

(defcontext my-contextl :strategy (priority))
(defcontext my-context2 :strategy (recency priority))

See also

3.1.5.3 Conflict Resolution
def cont ext

deftactic

-priority

instantiation

conflict-set

fire-rule

-priority

Summary

Implementsthe-pri ority tactic.

Package

kw

Signature

-priority instantiationl instantiation2 => result

Arguments

instantiation1 An instantiation object.
instantiation2] An instanti ation object.
Values

result A boolean.
Description

Conflict Resolution Tactic / Function

The conflict resolution tactic / function - pri ori t y returnstrueif and only if instantiationl is preferred to instantiation2 by
the conflict resolutiontactic- - priority, otherwisefase. The function isintended to be used primarily by including it in

the conflict resolution strategy for a context.

Examples

(defcontext my-contextl :strategy (-priority))
(defcontext my-context2 :strategy (recency -priority))
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See also

3.1.5.3 Conflict Resolution
def cont ext

deftactic

priority

instantiation

conflict-set

fire-rule

recency

Summary

Implementsther ecency tactic.

Package

kw

Signature

recency instantiationl instantiation2 => result

Arguments

instantiation10 An instantiation object.
instantiation2] An instantiation object.
Values

result A boolean.
Description

Conflict Resolution Tactic / Function

The conflict resolution tactic / function r ecency returnstrue if and only if instantiationl is preferred to instantiation2 by the
conflict resolution tactic r ecency, otherwise false. The function isintended to be used primarily by including it in the

conflict resolution strategy for a context.

Examples

(defcontext my-contextl :strategy (recency))
(defcontext my-context2 :strategy (priority recency))

See also

3.1.5.3 Conflict Resolution
def cont ext

deftactic

-recency

instantiation

conflict-set
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fire-rule

-recency

Summary

Implements the - r ecency tactic.

Package

kw

Signature

-recency instantiationl instantiation2 => result

Arguments

instantiation1 An instantiation object.
instantiation20 An instantiation object.
Values

result A boolean.
Description

Conflict Resolution Tactic / Function

The conflict resolution tactic / function - r ecency returnstrueif and only if instantiationl is preferred to instantiation2 by
the conflict resolution tactic - r ecency, otherwise false. The function is intended to be used primarily by including it in the

conflict resolution strategy for a context.

Examples

(defcontext my-contextl :strategy (recency))
(defcontext my-context2 :strategy (priority recency))

See also

3.1.5.3 Conflict Resolution
def cont ext
deftactic

recency
instantiation

conflict-set
fire-rule
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reset Function

Summary

Clears all objects from the object base.

Package

kw

Signature

reset

Description

Thefunctionr eset clearsall KnowledgeWorks objects (both KnowledgeWorks CLOS objects and K nowledgeWorks
structures) from the object base of the current inferencing state.

The list of KnowledgeWorks classes remains unaffected.
Examples

(reset)

See also

cl ear - al
clear-rul es

return Backward Chaining Goal

Summary

Removes the top-most context from the agenda.

Package

kw

Signature

return

Description

The backward chaining goal r et ur n takes the topmost context on the agenda and makes it the current context, discarding the
previous current context. When called from within arule, rule execution continues to the end and the next ruleto fire will be
from the new current context.
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Examples

(return)

See also

context

*sighal-kb-name-clash* Variable

Summary

Controls the behavior if name clashes occur in object creation.

Package

kw

Initial Value

.error

Description

Thevariable * si gnal - kb- name- cl ash* determines behavior when creating a new named KB abject with the same hame
as an existing KB object.

The possible values are:

ierror Signals aerror Continuing will replace the old object with the new object.

Jwar n Signals awarning and replaces the old object with the new object.

:qui et Replaces the old object with the new object.

specificity Conflict Resolution Tactic / Function
Summary

Implementsthe speci fi ci ty tactic.

Package

kw

Signature

speci ficity instantiationl instantiation2 => result

Arguments

instantiation10 An instantiation object.
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instantiation20] An instantiation object.
Values

result A boolean.
Description

The conflict resolution tactic / function speci fi ci t y returnstrueif and only if instantiationl is preferred to instantiation2
by the conflict resolution tactic speci fi ci ty, otherwise false. The function isintended to be used primarily by including it
in the conflict resolution strategy for a context.

Examples

(defcontext my-contextl :strategy (specificity))
(defcontext my-context?2
:strategy (priority specificity))

See also

3.1.5.3 Conflict Resolution
def cont ext

deftactic
-specificity
instantiation

conflict-set

fire-rule

-specificity Conflict Resolution Tactic / Function

Summary

Implements the - speci fi ci ty tactic.

Package

kw

Signature

-specificity instantiationl instantiation2 => result

Arguments

instantiation1 An instantiation object.
instantiation2] An instantiation object.
Values

result A boolean.
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Description

The conflict resolution tactic / function - speci fi ci ty returnstrueif and only if instantiationl is preferred to instantiation2
by the conflict resolution tactic - speci fi ci ty, otherwise false. The function isintended to be used primarily by including

it in the conflict resolution strategy for a context.

Examples

(defcontext my-contextl :strategy (-specificity))

(def cont ext my-context?2

:strategy (priority -specificity))

See also

3.1.5.3 Conflict Resolution
def cont ext

deftactic
specificity
instantiation

conflict-set

fire-rule

standard-context

Summary

The standard meta-interpreter context.

Package

kw

Signature

st andar d- cont ext

Description

Backward Chaining Goal

The backward chaining goal st andar d- cont ext isthe built-in goal that implements a meta-interpreter for the default

(normal) behavior of acontext. It isasif defined by therule:

(defrul e standard-context :backward

( (st andar d- cont ext)
<- -

(start-cycle)

(instantiation ?instantiation)
(fire-rule ?instantiation)

(cut)
(standard-context)))

Examples

(defcontext my-contextl

meta (((format t "~%Entering context My- CONTEXT1"))
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(standard-context)))

See also
def cont ext
start-cycle
instantiation
fire-rule

standard-kb-object Class

Summary

A class of objectsfor use in the object base.

Package

kw

Superclasses

st andar d- obj ect

Description
The class st andar d- kb- obj ect isthe mixin class for (unnamed) KnowledgeWorks CLOS objects.

Subclasses of st andar d- kb- obj ect aretypically defined using the macro def - kb- cl ass.

Examples

(defclass driver (standard-kb-object)
((location) (allocated-truck)))
See also

def - kb-cl ass
naned- kb- obj ect

start-cycle Backward Chaining Goal

Summary

Used in the meta-interpreter to start the cycle.

Package

kw
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Signature

start-cycle

Description

The backward chaining goal st art - cycl e isonly relevant when writing a meta-interpreter for acontext. start-cycl e

must be called at the start of every forward chaining cycle asit performs some essential housekeeping.

Examples

(start-cycle)

See also

fire-rule
instantiation

def cont ext
standar d-context

start-kw

Summary

Starts the KnowledgeWorks programming environment.

Package

kw

Signature

start-kw &key host

Arguments

hostd A string.

Description

Thefunction st ar t - kw starts the KnowledgeWorks programming environment from the initial prompt when the

Function

KnowledgeWorks image is started. If the LispWorks IDE is already running, st ar t - kw adds the KnowledgeWorks menu so

that the podium becomes the K nowledgeWorks Podium.

On GTK+ and Motif the environment is displayed on the machine specified by host, defaulting to the machine on which the

KnowledgeWorks image is running. Other platformsignore host.

Examples

(start-kw
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test

Summary

Evaluates a Lisp form as a backward chaining goal.

Package

kw

Signature

test lisp-form

Arguments

lisp-formO A single Lisp form.

Description

Backward Chaining Goal

The backward chaining goal t est succeedsif and only if lisp-form returns a non-nil value. Any currently bound variables

may be used in the lisp form.

t est can aso be used as aforward chaining pre-condition, as described in 3.1.2 Forward Chaining Syntax.

Examples

(test (> ?c 10))
(test (not (and (eq ?a ?b) (menber ?b ?c))))

undefcontext

Summary

Removes a named context and its rules.

Package

kw

Signature

undef cont ext context-name &r est ignore

Arguments
context-namel] A symbol which names a context.
ignorel] Ignored arguments.
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Description
The macro undef cont ext removes the context named context-name and al therulesin it.

ignoreis not used and is only provided so that "un" may be prepended to a context definition in an editor buffer and evaluated
to remove the context.

Examples

(undef cont ext ny-context)

See also

def cont ext

undefrule Macro

Summary

Removes arule.

Package

kw

Signature

undef rul e rule-name &rest ignore

Arguments

rule-name] A symbol which names arule.
ignorel] Ignored arguments.
Description

The macro undef r ul e removes the rule named rule-name and any unfired instantiations of that rule.

ignoreis not used and is only provided so that "un" may be prepended to arule definition in an editor buffer and evaluated to
removetherule.

Examples

(undefrul e nmy-rul el)

See also

defrul e
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with-rule-actions Macro

Summary

Allows rule syntax to be embedded in Lisp code.

Package

kw

Signature

wi t h-rul e-acti ons bound-variables &ody body => successp

Arguments

bound-variables] A list of variables (each starting with ?).
body[] A rule body.

Values

chce$p|:| A boolean.

Description

Themacrowi t h-rul e- act i ons macro enables rule syntax to be embedded within Lisp.

body is executed just asif it were the right hand side of aforward or backward chaining rule. All variablesin body (each
starting with ?) are taken to be unbound unless found in the list bound-variables, in which case its value is taken from the
Lisp variable of the same name. wi t h-rul e- act i ons issimilar to the function any but can be compiled for efficiency.

successpist if the body succeeds (that is, all clauses are successfully executed) or ni | if any of the clauses fail.

Any subgoal s that match the object base will only find objects from the current inferencing state.

Examples

(defun nmy-fn (?x)
"prints all the lists which append to give ?x and
then returns NL"
(with-rule-actions (?x)
(append ?a ?b ?x)
((format t "~%S and ~S append to give ~S"
?a ?b ?x))

(fail)))

See also

any
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A.1l Introduction

A.1.1 Overview

Common Prolog is alogic programming system within Common Lisp. It conforms closely to Edinburgh Prolog and at the
same time integrates well with Lisp. The basic syntax of Common Prolog is Lisp-like, but an Edinburgh syntax trandator is
included that provides the ahility to use pre-existing code. The implementation of Common Prolog was motivated by the
desire to use the logic programming paradigm without having to give up the advantages of a Lisp development environment.
Common Prolog istightly integrated with Lisp and can be easily used in a mixed fashion with Lisp definitions even within
the same source file. Common Prolog predicates are compiled into Lisp functions which may then be compiled by a standard
Lisp compiler. Substantial effort has gone into providing a powerful debugging environment for Common Prolog, so that it
can be used when building serious applications. The implementation of Common Prolog is based loosely on the Warren
Abstract Machine (WAM) modified to take advantage of a Lisp environment's built in support for control flow and memory
alocation. (For more details of the WAM, see An Abstract Prolog I nstruction Set, by David H D Warren, Technical Note
309, SRI International, October 1983.)

A.1.1.1 Starting Common Prolog

Common Prolog may be loaded into an image with the function call:
(require "prol og")

Thiswill load the Common Prolog system. If Common Prolog will be used extensively, it may be worthwhile to save an
image with it pre-loaded. Alternatively, you may simply insert the call above into your LispWorks initialization file (usually
.l i spworks).

For information about saving an image and the LispWorks initialization file, see the Release Notes and Installation Guide.

Note: If you load KnowledgeWorks, then Common Prolog is loaded as part of this.

A.2 Syntax

Common Prolog uses a Lisp-like syntax in which variables are prefixed with "?' and normal Lisp prefix notation is used.
Goals are represented as either listsor simple vectorse.g. (reverse (1 2 3) ?x) or #(menber ?2x (1 2 3)). A
symbol beginning with ? may be escaped by prefixing another ?.i.e. ?f oo isthe variable named f oo; ??f oo isthe symbol
?f oo.

The definition of append/3 from Prolog:

append([], X X).
append([U X], Y, [UZ]) :-
append( X, Y, 2)

translates to;
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(defrel append
((append () ?x ?x))
((append (?u . ?x) ?y (?u . ?z2))
(append ?x ?y ?z)))

Unlike many Lisp-based logic systems, Common Prolog uses simple vectors to represent Prolog structured terms. Thus,
functor, arg, and=. . all behavein astandard fashion:

(arg 2 (foo 3 4) (3 4))

(arg 2 #(foo 3 4) 4)

(functor (foo 3 4) \. 2)
(functor #(foo 3 4) foo 2)

. #(foo 3 4) (foo 3 4))

. (foo 3 4) (\. foo (3 4)))

(=.
(=
A.3 Defining Relations

The normal method of defining relationsin Common Prolog isto usethedef r el macro:

(defrel <relation name>
[ (decl are decl aration*)]
<clausel>

<clauseN>)

where each <clause> is of the form:

( <clause-head>
<subgoal 1>

<subgoalN>)

and declarations may include: (nmode ar g- node*) and any of the normal Lisp optimization declarations. Mode
declarations determine how much clause indexing will be done on the predicate and can a so streamline generated code for a
predicate that will only be used in certain ways. A mode declaration consists of the word "MODE" followed by a mode spec
for each argument position of the predicate. The possible argument mode specs are:

? Generate completely general code for this arg and don't index on it.
7% Generate completely general code and index.
+ Generate code assuming this argument will be bound on entry and index.

Generate code assuming this argument will be unbound on entry and don't index.

The default mode specs are ?* for the first argument and ? for all the rest.

A.4 Using The Logic Interpreter

The Common Prolog system comes with abuilt-inr ead- quer y- pri nt loop similar to a Prolog interpreter loop. To run it,
make sure the common-prolog package is accessible and type: (r gp) . You will be presented with the prompt: ==>. At this
point you may type in goal expressions, for example:

| ==> (append ?x ?y (1 2))
I
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| 2X
| 2Y

NI L
(12

Now Common Prolog is waiting for you to indicate whether or not you wish more solutions. If you press Ret ur n, you will
get the message OK and return to the top level:

[?X = NIL

| ?Y = (1 2)<RETURN>
I

| OK.

| ==>

A.4.1 Multiple Solutions

If you hit; (semicolon) following the retrieval of a solution, the system will attempt to resatisfy your goal:

[?X = NIL
[?Y = (1 2);
I

| ?X = (1)

[ ?Y = (2);

I

[?2X = (1 2)
|?Y = NIL;
I

| NO.

| ==>

When no more solutions remain, NO. is displayed and you are back at the top level.

A.4.2 Multiple Goals
To request the solution of multiple goals, use: (and <goall> ... <goalN>).

For example:

==> (and (menber ?x (2 3)) (append (?x) (foo) ?y))

2
(2 FOO

A.4.3 Definitions

It is possible to type logic definitions directly into the interpreter. The resulting Lisp code will be compiled in memory and
you may use the definition immediately, for example.:

| ==> (defrel color

| ((color red))

| ((col or blue))

| ((color green)))
I
I

<... various conpilation nessages ...>
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YES.

==> (col or ?x)

-~
X

I
I
| K
I
I
I
| 7 RED

A.4.4 Exiting the Interpreter

The Common Prolog interpreter may be exited by typing:

| ==> (halt)

A.5 Accessing Lisp From Common Prolog

It is apparent from the Common Prolog syntax that the first element of any valid goal expression must be a symbol. Common
Prolog takes advantage of this fact and gives a special interpretation to agoal with alist in thefirst position. A listinthecar
of agoal istreated as a Lisp expression with normal Lisp evaluation rules. Any logic variablesin the expression are
instantiated with their values. (They must be bound). The rest of the goal expression should be alist of expressionsto be
unified with the values returned by the Lisp evaluation. Any extra values returned are ignored, and any extra expressionsin
the tail of agoa are unified with new unbound variables.

A.5.1 Examples

[==> ((print "foo"))
I
| " foo"
| YES.
I
|==> (and (= ?x 3) ((* ?x ?x) ?y))
; Note that "?y" is unified with 9

| 2X
| 2Y
I

|==> ((* 3 3) 10)

3
9

==> ((floor 3 4) ?x ?y)

0
3

N )
< X
Inn

| ==> ((floor 3 4) ?x)

)
X

=> ((* 3 4) ?x ?y)

12

?0

note that system generated variables | ook |ike:
7 ?<integer>

N )
<X
nn
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=> ((typep 3 'integer) ?x)
?X =

=> ((typep 3 'integer) t)

<
[Tl

S.

=> (and ((floor 5 3) ?x) ((floor 4 3) ?x))

-~
X

=> ((cons 3 4) (?x . ?y))

3
4

) )
< X
Inn

| =
I
I
I
| =
I
I
I
| =
I
| 7
I
| =
I
| 7
I
| ==> (and (= ?op *) ((list 20p 3 4) ?y) (call (?y ?z)))
I

| 20P = *
|2Y = (* 3 4)
|72 = 12

I

| ==> (and (defrel fact

| ((fact 0 1))

| ((fact ?x ?y)

| ((- 2 1) 2w

| (fact ?w ?z)

| ((* 2z 2%) ?y)))
| (fact 10 ?result))
I

I

I

I

I

?X =70
?Yy = 7?1
W= ?2
?Z = 7?3
?RESULT = 3628800

A.6 Calling Prolog From Lisp

There are several entry points provided for calling Prolog from Lisp. The main interface functioniscalled | ogi ¢ and has
numerous options. The basic formis:

(1 ogi ¢ <goal>
:return-type <return-type>
cal |l <all-type>
: bag- exp <bag-exp>)

The keyword arguments are interpreted as follows:

: ret ur n-t ype describes what to do with a solution when one is found. Possible values of : r et ur n- t ype are:

:di spl ay Display variable bindings and prompt user (the option used by ther ead- quer y- pri nt loop).
cfill Instantiate the goal expression and return it.
: bag Instantiate <bag-exp> and return it.
calist Return an alist of variables and bindings.
Thedefaultis: fill.

:al | tellswhat to do with multiple solutions. Possible valuesof : al | are:
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nil Return the first solution.
:val ues Return multiple solutions as multiple values.
(i st Return alist of the solutions.

: bag- exp isan expression that should be instantiated with the bindings from a solution. Thisis only meaningful if
‘return-typeis: bag.

A.6.1 Examples

(logic "(color ?x) :return-type :display)
writes:

?X = RED<wai t for input>

(logic "(color ?x) :return-type :fill)
returns:

(COLOR RED)
T

(logic "(color ?x) :return-type :alist)

returns:

((?X . RED))

T

(logic "(color ?x) :all :list)
returns:

((COLOR RED) (COLOR BLUE) (COLOR GREEN))
T

(logic '"(color ?x)
:return-type : bag
:bag-exp '(?x is a color)
call :val ues)

returns;

(RED IS A COLOR)
(BLUE I'S A COLOR)
(GREEN |'S A COLOR)
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A.6.2 Interface Functions

There are three additional waysto call | ogi ¢, which are described in this section.

A.6.2.1 any, findall and findallset

Three simple interface functions call | ogi c. They areany, fi ndal | , andfi ndal | set . Each takes two arguments: aresult
expression to instantiate and a goal expression. any returnsthe first solution found. fi ndal | returnsall solutions.
findal | set returnsall solutions deleting duplicates.

Assuming the definitionsfor f act and col or from the previous examples.

| (any '(?x is the factorial of 5) '(fact 5 ?x))

returns:

I
| (120 1'S THE FACTORI AL OF 5)

| (findall '(?x is a color) '(color ?x))

returns:

I
| ((RED 1S A COLOR) (BLUE I'S A COLOR)
(GREEN IS A COLOR))

I
[(findall '?y '(or (= ?y 5) (= ?y 5)))
returns:

I
| (5 5)

I
| (findallset '"?y '"(or (=?y 5) (= 7?2y 5)))

returns:

I
| (5)

findall andfindal | set will hang if agoal expression generates an infinite solution set.

More powerful all solution predicates (bagof and set of ) are available from within Common Prolog.

A.6.2.2 deflogfun

A different interface is available for predicates which will be called often from Lisp. The macro def | ogf un may be used to
generate normal Lisp functions that run with precompiled goals.

(defl ogfun break-up (y) (append ?a ?b y) (?a ?b))

then:
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(break-up ' (foo bar baz))

returns:

(NIL (FOO BAR BAZ))
N

(break-up ' (foo bar baz) :all :values)

returns:

(NI'L (FOO BAR BAZ))
((FOO (BAR BAZ))
((FOO BAR) (BAZ))
((FOO BAR BAZ) NiL)

(break-up '(foo bar baz) :all :list)

returns:

((NI'L (FOO BAR BAZ))
((FOO) (BAR BAZ))
((FOO BAR) (BAZ))
((FOO BAR BAZ) NIL))
T

The generated function works like the Lisp functionsany and f i ndal |, returning solutions to a prolog expression.

Theform:

(defl ogf un name args sample-expr return-expr)

defines a Lisp function called name, whose lambdallist isthe list args. The function will also take a keyword argument : al | .
If thefunctioniscalledwith: al | nil (thedefault), then it returns thefirst solution, like any. If the function is called with
call t,thenitreturnsalist of al the solutions, likefi ndal | . If thefunctioniscalled with: al | : val ues, then it returns
multiple values, with one value per solution.

The sample-expr is like the second argument to any, that is, it isthe prolog query expression. The return-expr islike the first
argument to cl og: any, that is, it defines how the result will be formed from the results of the query. If any of the symbols
mention in args appears in sample-expr or return-expr, then its value is substituted. All other symbolsin sample-expr and
return-expr remain unchanged.

A.6.2.3 with-prolog

A final interface mechanismiswi t h- pr ol og, which alows you to embed prolog into an arbitrary lisp function. Lisp
variables are referenced in Prolog using "?. <name>".

(defun palindronmep (x)
(wi th-prol og
(append ?a (?b . ?c) ?.x) ; note "?.x" reference
(or (reverse ?a ?c)
(reverse ?a (?b . ?c¢)))))

(palindronmep ' (yes no maybe))

returns:
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NI L

(palindronep '(yes no maybe no yes))

returns:

T

The body of awi t h- prol og returnst if it succeeds and a non-local exit is not executed. It returnsni | on failure.

A.7 Debugging

Common Prolog provides a standard 4-port debugging model (cal | exit redo fail).

Tracing, Spy Points, Leashing, and Interactive Debugging are each discussed separately in this section.

A.7.1 Tracing

Exhaustive tracing is available with Common Prolog through the use of: (trace) . After executing (trace), all goalswill
be displayed until control is returned to the top level loop, nodebug is executed or not r ace is executed.

A.7.1.1 Tracing rules

You can turn on tracing for backward chaining from Lisp by running:
(clog:logic '(and (clog:unleash) (trace)))

There are no command line tools for tracing forward chaining rules directly, but the RHS of each rule is run using a backward
chaining rule with the same name, so they also appear when you trace backward chaining.

You could also add tracing to forward rules by defining a Meta Rule Protocol, for example like the explanation facility
described in 6.1.1.3 A Simple Explanation Facility.

A.7.2 Spy Points

Spy points are the most important debugging facility in Common Prolog. They are used in the sameway t r ace isused in
Lisp. After executing (spy f oo), al events associated with satisfying f oo goalswill be traced and the user will enter a
debugging command loop at every port (see A.7.4 I nter active Debugging below). A user can also specify (spy (foo 3)),
(spy (foo bar)),or(spy ((foo 3) bar)) toplacespy pointsonf oo goalswith arity 3, on all predicatesfor f oo
and bar , or on f oo with arity 3 and all predicatesfor bar respectively. Spy points are turned off with (nospy <spypoints>) .
If no spy points are mentioned, nospy will turn off all spy points.

A.7.3 Leashing

L eashing allows the user to control execution while tracing for goals that are not spied. Spied goals cause execution to enter a
debugging command loop whenever they are reached. Leashing provides the same functionality for unspied goals. A user
may choose to enter a debugging command loop at any subset of portsby using (1 eash events) where events may be: cal | ,
redo, exit orfail. Leashing may be turned off using (unl eash) .
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A.7.4 Interactive Debugging

When Common Prolog execution enters a debugging command loop, the user has many options, which may be listed with 2,
for example:

==> (spy menber)

MEMBER 2))
S.

RE2

==> (nmenber 3 ?x)

[1] CALL: (MEMBER 3 ?0)? ? <- user types ?

(c)reep - turn on exhaustive tracing

(s)kip - skip until another port is
reached for this goa

(l)eap - turn off tracing until a spy
point or this goal is reached

(b)reak - enter a recursive
read/ query/print |oop

(d)ispl ay - display a listing for the
current goa

(q)uit - quit to top leve

(r)etry - try to satisfy this goal again

(f)ail - cause the current goal to fai

(a) bort - exit Common Prol og

? - display this information

?

Inalittle nore detail..

creep - causes exhaustive tracing of the
next goa
skip - ignores spy points and executes

wi t hout di spl aying anything unti
this goal is reached again
either at an exit, fail

or redo port

| eap - turns off exhaustive tracing unti
a spy point or this goal is
reached
br eak - enters a recursive interpreter |oop

so that the user may query

val ues, redefine a predicate, etc.
di splay - uses "listing" to display the

listing of the current goa

quit - returns to the top level interpreter
| oop
retry - causes execution to return to the

call port of this goal as if
this goal had just been reached for
the first tine.

fail - causes execution to junp to the fai
port of this goa
abort - conpletely exit Conmmon Prol og

Continuing the example:

| d <- user selects display

I
| Conpi | ed procedure:
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I
| (DEFREL MEMBER
| ((MEMBER ?X (?2X . ?)))
I
I

((MEMBER ?X (? . ?Y)) (MEMBER ?X 2Y))) ? ¢

...user selects creep

[[1] EXIT: (MEMBER 3 (3 . ?0))? r
| ...user selects retry

I
|[1] CALL: (MEMBER 3 ?0)? f <-user selects fai

I
|[1] FAIL: (MEMBER 3 ?0)? r <- one nore tine

[[1] CALL: (MEMBER 3 20)? s <- skip

I
[[1] EXIT: (MEMBER 3 (3 . 20))? |

| ?X = (3 . ?0); <- nore solutions
I
[[1] REDO (MEMBER 3 (3 . ?0))? ¢
I

<- leap

<- creep

|[2] CALL: (MEMBER 3 20)? b <- break

==> (nospy)

| NIL <- current spylist
| YES.

| K

I
| ==> (halt) <- return to origina
|? | <- leap

?2X = (20 3 . ?1)<cr>

Another example:

| ==> (defrel reverse

I ((reverse () ()))

| ((reverse (?x . ?y) ?z)
| (reverse ?y ?w)

| (append ?w (?x) ?z)))
| <noi se. . >

I

| 2X = 20
|?2Y = 71
| 2Z = 72
| 2W= 23
I

| OK.

| ==> (defrel append
((append () ?x ?x))

I
I
| (append ?x ?y ?z)))
I

<noi se. . >
| X = 20
|?U = 21
| ?Y = 22

((append (?u . ?x) ?y (?u

execution

?2))
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|72 = 73

I
| OK.

| ==> (unl eash)

I
| YES.

| OK.
I

| ==> (trace)

[1] CALL:
[2] CALL:
[3] CALL:
[4] CALL:
[4] EXIT:
[5] CALL:
[5] EXIT:
[3] EXIT:
[6] CALL:
[7] CALL:
[7] EXIT:
[6] EXIT:
[2] EXIT:
[8] CALL:
[9] CALL:
[10] CALL:
[10] EXIT:
[9] EXIT:
[8] EXIT:
[1] EXIT:
?

1] REDO (REVERSE (1 2 3) (3 2 1))
8] REDO (APPEND (3 2) (1) (3 2 1))

| [

| [

|[9] REDO
| [10] REDO
|[10] FAIL:
|[9] FAIL:
|[8] FAIL:
|[2] REDO
|[6] REDO
|[7] REDO
[[7] FAIL:
|[6] FAIL:
|[3] REDO
|[5] REDO:
|[5] FAIL:
|[4] REDO
|[4] FAIL:
|[3] FAIL:
[2] FAIL:
[1] FAIL:
I

==> (reverse (1 2 3) ?x)

(REVERSE (1 2 3) 20)
(REVERSE (2 3) ?0)

( REVERSE (3) 20)
(REVERSE NI L ?20)
(REVERSE NIL NIL)
(APPEND NI L (3) ?0)
(APPEND NIL (3) (3))
(REVERSE (3) (3))
(APPEND (3) (2) ?0)
(APPEND NIL (2) ?0)
(APPEND NIL (2) (2))
(APPEND (3) (2) (3 2))
(REVERSE (2 3) (3 2))
(APPEND (3 2) (1) 20)
(APPEND (2) (1) ?0)
(APPEND NIL (1) ?0)
(APPEND NIL (1) (1))
(APPEND (2) (1) (2 1))

(APPEND (3 2) (1) (3 2 1))
(REVERSE (1 2 3) (3 2 1))

(APPEND (2) (1) (2 1))
(APPEND NIL (1) (1))
(APPEND NIL (1) <0)

(APPEND (2) (1) 20)

(APPEND (3 2) (1) <20)

(REVERSE (2 3) (3 2))

(APPEND (3) (2) (3 2))

(APPEND NIL (2) (2))

(APPEND NIL (2) ?0)

(APPEND (3) (2) 20)

(REVERSE (3) (3))

(APPEND NIL (3) (3))

(APPEND NIL (3) <?0)

(REVERSE NI L NL)

(REVERSE NI L ?0)

(REVERSE (3) ?0)

(REVERSE (2 3) ?0)

(REVERSE (1 2 3) <?0)
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A.8 Common Prolog Macros
Macros may be defined within the logic system using the form:

(defrel macro <name> <arg-list> <body>)

which is effectively the same as a Common Lisp def macr 0. Logic macros are expanded before variable trand ation so that
logic variables may be treated as atoms. def r el nacr o forms must have a fixed number of arguments. This allows different
predicates with the same name but different arities to be defined. If you want to define a special form with an arbitrary
number of arguments, usedef r el - speci al - f or m macr o.

A.8.1 Example

(defrel macro append3 (x y z w)
(let ((iv (make-internal-var)))
“(and (append ,x ,y ,ivV)

(append ,iv ,z ,wW))))

==> (append3 (1) (2) (3) ?y)

2Y = (1 2 3)

A.9 Defining Definite Clause Grammars
Thedef gr anmar macro can be used to define a definite clause grammar (DCG), which is arelation that determines whether
the start of alist of tokens (a sentence) matches a particular grammar. The remaining tokensin the list become the sentence
tail.
The relation has the form:

(<grammar name> <sentence> <sentence tail> <extra argument >*)
wherethe <extra ar gunent > items are terms defined below.

The syntax of the defgrammar macrois:

(def granmar <granmmar name>

<rul e>*)
<rule> ::= (<l hs> <rhs>*)
<l hs> ::= <grammar name>

(<granmmar nane> <ternp*)
((<grammar nane> <ternp*) <newternp*)

<rhs> ::= <atonp

| <var>

| (<other grammar nanme> <ternp*)

| <lisp clause>

| (call <ternp)

| (cut)
<lisp clause> ::= (<non-atonmic lisp fornr <ternp*)
<non-atonic lisp fornk ::= (<lisp function nane> <lisp arg>*)
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<granmmar nane> isthe same symbol as the one naming the defgrammar.

<ot her grammar nane>isasymbol naming another defgrammar.

<at on® is an atom, which forms the words of the sentence to be matched.

<var > isavariable reference.

<t er n» and <newt er > are any Common Prolog logic expression, including a variable.
<l'isp function nane>isasymbol naming aLisp function.

<lisp arg>isany Lispform, whichisevaluated and passed to the function.

Within the <I hs>, extra arguments can be added by specifying <t er n»s. Every <r ul e> must specify the same
<grammar nanme> asthedef gr anmar form and have the same number of extra arguments.

If the <I hs> specifies <newt er m> forms, then they are pushed onto start of the sentence tail if the rule matches. This
corresponds to the "pushback lists' or "right-hand context” in traditional Prolog DCG syntax.

The meaning of the various <r hs> itemsis as follows:
* <at o> matches that atom in the sentence.
« <var > isunified with the next item in the sentence.

e (<other grammar nanme> <terne,*) callsthe grammar relation <ot her granmar name> ontherest of the
sentence. The optional <t er m»> arguments are passed to the relation as its extra arguments.

» <lisp clause>evauatesthe<non-atonic |isp forn>asalispform and unifiesthe valuesthat it returns with
the <t er nesthat follow it.

e (call <terne) cals<tern» asanorma Prolog relation.
e (cut) calsthenormal Prolog cut relation.
The phr ase predicate can be used to call aDCG.

A.9.1 Examples

Here are some examples of using def gr ammar .

A.9.1.1 Example 1: A simple definition.

This example shows the Common Prolog trandation of the grammar shown at the top of
http://cs.union. edu/ ~striegnk/| earn-prol og- now ht m / node59. ht .

(def grammar gram det
(gramdet the)
(gramdet a))

(defgrammar gramn
(gram n wonan)
(gramn man))

(def grammar gramv
(gramv shoots))

(def grammar gram np
(gramnp (gramdet) (gramn)))
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(def grammar gramvp
(gramvp (gramv) (gramnp))
(gramvp (gramv)))

(defgrammar grams
(grams (gramnp) (gramvp)))

Note the use of symbols for terminals and lists for non-terminals. They all use the first form of the <I hs> and have no extra
terms on the <r hs>, so all of the relations are binary.

The following will both succeed and bind ?x to thelist (f oo bar):

(clog:any "?x '(grams (a woman shoots foo bar) ?x))
(clog:any '?x '(grams (a wonan shoots the man foo bar) ?x))

A.9.1.2 Example 2: Using extra arguments.

(def granmmar one- of
((one-of ?word) ?word))

(def grammar two- of
((two-of ?word) (one-of ?word) (one-of ?word)))

Each of these defines a 3-ary relation, whose extra argument is the word to match. When the relations are called, the word
will typically be bound to a symbol from the sentence to match.

The following will succeed and bind ?x to thelist (f oo bar):

(clog:any '?x '(two-of (start start foo bar) ?x start))

The following will both fail because the sentences do not begin with two st art symbols:

(clog:any "'?x '(two-of (not-start start foo bar) ?x start))
(clog:any "?x '(two-of (start not-start foo bar) ?x start))

A.10 Edinburgh Syntax

Common Prolog provides atranglator from Edinburgh syntax to allow usersto port pre-existing code.
Theconsul t predicate operatesonly on. pl files:

e consul t (' xxx. pl ') meansconsult filexxx. pl .

e consul t (' xxx"). meansfind afile named xxx. pl and consult it.

Thereconsul t predicate can operate on aLisp sourcefile, since conpi | e_and_reconsul t (* xxx. pl ') producesalisp
binary filexxx. ?f asl . Thatis, reconsul t will load fasl and lisp filesaswell as. pl files:

e reconsul t (' xxx. pl ') meansreconsult file xxx. pl .

e reconsul t (' xxx') meanslook for afile named xxx. ?f asl and load it, or if none found, look for xxx. pl and
reconsult it, or if none found look for xxx. |'i sp and load it, or load xxx.

Loading acompiled fileisequivalenttor econsul t .

conpi | e_and_reconsul t compiles afile and reconsults the result.
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Edinburgh syntax may also be used to interact with Common Prolog through the use of a different read-query-print loop. To
use Edinburgh syntax, use (er gp) instead of (r qp) to start your command |oop.

A.11 Graphic Development Environment

Common Prolog includes a graphic environment, consisting of a specialized listener and graphic debugging tools. With the
debugging tools it is possible to step through a program at the source level and control the 4-port debugger using the mouse.
Call trees for predicates may al so be displayed and manipulated.

The specialized listener provides mouse control over:
 File editing, compiling, consulting and reconsulting.
» Debugging control flow (creep, leap, skip, etc.).
 Leashing of debugging ports.
» The addition and deletion of spy points.
The Logic Listener interaction is similar to anormal Lisp Listener and will accept normal Lisp expressions except that:
1. Any expression that can be interpreted as Common Prolog will be handled by the Logic subsystem.

2. If aline consisting of just “?-' is entered, the Logic Listener will go into an Edinburgh ( er gp) loop.

A.12 Built-in Predicates

The built-in predicates listed in the table below are exported from the common- pr ol og (cl og) package.

== (?x ?y) same as Prolog\ ==
= (?x ?y) standard Prolog
=. (?x ?y) standard Prolog
== (?x ?y) standard Prolog
@ (?x ?y) same as Prolog except all variables sort asidentical
@< (?x ?y) ditto

@ (?x ?y) ditto

@= (?x ?y) ditto

append (?x ?y ?z) standard Prolog
arg (+index +term ?val ue) standard Prolog
asserta (+exp) standard Prolog
assertz (+exp) standard Prolog
atom c (?x) standard Prolog

bagof (?exp

standard Prolog (unusual syntax)*

(+goal . +ex-vars)

?bag)

cal | (+exp) standard Prolog
clause (+head ?tail) standard Prolog
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debug ()

cause debugging information to be saved for each call
whether it is spied or not

debuggi ng ()

display alist of all spied goals

defdetre
(+nane &rest +cl auses)

define arelation and declare it to be deterministic

def gr ammar
(+nane &rest +rul es)

define agrammar rule

defrel
(+name &rest +cl auses)

define arelation

defrel macro
(+nane +args &rest +body)

define alogic macro

defrel -speci al -form nmacro
(+nane +args &rest +body)

like defrelmacro but can have &rest in +ar gs. Use of
this form will shadow all predicates named +nane
regardless of arity.

determni stic (+nane)

declare the relation called ?nane to be deterministic

erase (+ref)

delete the predicate with database reference ?r ef from
the database

fail ()

standard Prolog

findall
(?exp +goal ~?result)

generate all solutions to ?goa and instantiate ?exp with
thevalues. Return alistin ?resul t .

findall set
(?exp +goal ?result)

same as findall/3 but removes duplicates

functor
(?term ?functor ?arity)

standard Prolog

halt ()

exit Common Prolog

i nteger (?x)

standard Prolog

is (?result +exp)

standard Prolog

keysort (+in ?out)

standard Prolog except uses alist style cons pairs

| eash (+event-spec)

cause the interpreter to pause and ask for input when one
of the leashed eventsistraced. An event-spec is one of:
call,exit,redoorfail, oralist of ports.

listing
(+nane &optional +arity)

display alisting of the named predicate or listings for
each arity if no arity is specified

menber (?x ?y)

standard Prolog

nodebug ()

leave debug mode (cease saving debug info for non-
spied goals)

nonvar (?x)

standard Prolog

nospy (+args)

remove +ar gs from thelist of spied goals. +args may be
apredicate name or alist of predicate names. Unspy all
goalsif +args isni |

not (+x)

standard Prolog

notrace ()

turn off exhaustive tracing for debugged goals
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once (+exp)

satisfy +exp asagoal once, then fail on retrying even if
+exp has more solutions: this can be used to make a call
deterministic so that the compiler can perform last call
optimization

out put-defrels
(+name ?defrels)

return alist of def r el expressions derived from the
dynamic clauses associated with ?nane

read-term (?term read in aterm

recorda (+exp ?val ?ref) standard Prolog
recorded (+term ?val ?ref) standard Prolog
recordz (+exp ?val ?ref) standard Prolog
repeat () standard Prolog
retract (+clause) standard Prolog

setof (?exp
(+goal . +ex-vars)
?bag)

standard Prolog (unusual syntax)*

sort (+in ?out)

standard Prolog

spy (+args)

spy +ar gs. +ar gs may be a predicate name or alist of
predicate names. If arity is hot mentioned for a predicate
name, predicates of all arities with that name are spied.

trace ()

turn on tracing for debugged goals, also turn on
debugging for the next top level goal

transl ate-vars
(?intern ?extern)

tranglate back and forth between internal and external
variable representations. Can be used to pretty up the
writing of terms containing variables

true ()

standard Prolog

unl eash (+event-spec)

Undo leashing for +event - spec. +event-spec may be
aport or alist of ports. If +event - spec isni |, all
ports are unleashed.

var (?x)

standard Prolog

phrase +exp ?list

standard Prolog way to call agrammar rule

phrase +exp ?list ?tail

standard Prolog way to call agrammar rule

* set of and bagof in standard Prolog use a special syntax for existentially quantified variables, for example:

?- setof (X, YAfoo(X YY), Z2).

In Common Prolog, this would look like:

==> (setof ?x ((foo ?x ?y) ?y) ?z)

So, agoal with no existentially quantified variablesis nested in an extra set of parentheses:

==> (bagof ?x ((bar ?x)) ?z)
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A.13 Adding Built-in Predicates

Common Prolog provides severa special forms for adding new predicates written in Lisp. Each one is described below, with
an example.

A.13.1 The defdetpred form

The syntax of thisformis:

(def det pred <name> <num-args> <body>)

which defines a simple predicate that just runs Lisp code and does not have to unify any variables. Arguments are referenced
with: (speci al -arg <num>) . The body succeeds by default, but if afailure case arises, use:
(detpred-fail <name> <numargs>).

For example:

(defdetpred nmy-integer 1
(unless (integerp (special-arg 0))
(detpred-fail my-integer 1)))

A.13.2 The defdetunipred form

The syntax of thisform is:

(def det uni pred <name> <num-args> <unifierl unifier2>
<aux-vars> <body>)

def det uni pr ed is used when the defined predicate needs to unify values with arguments (or unify in general). The body is
executed and, if successful, (that is, det pred- f ai | has not been called) unification is performed on the two unifiers. (If
more than two items need to be unified, cons up lists of itemsto unify).

For example:

(defdetunipred ny-arg 3 (tenpl tenp2)
(templ tenp2 index term val ue)
(setf index (special-arg 0)
term (special-arg 1)
val ue (special-arg 2))
(unl ess (and (nunberp index)
(plusp index)
(or (and (termp term
(< index (length term))
(and (consp term
(< index 3))))
(detpred-fail my-arg 3))
(if (consp term
(setf tenmpl (if (= index 1)
(car term
(cdr term))
(setf tenmpl (termref termindex)))
(setf tenp2 val ue))
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A.14 Edinburgh Compatibility Predicates

The following predicates al have their standard Edinburgh definitions (note that these are written as Lisp symbols, so\ isa
Lisp escape character, meaning that \ \ + is the Edinburgh definition named \ +):

-->
->
/
11

<<

=<

current-op
di spl ay
get
getO

is

name

n

put

see
seei ng
seen
ski p
tel
telling
told
ttynl
ttyput
wite
witeq
|is]
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B.1 The Tutorial
The code for the tutorial (2 Tutorial) is reproduced for easy reference.

; -*-nmode : lisp ; package : kw user -*-

(i n-package kw user)

(def -kb-cl ass node ()

((animal :initformnil :accessor node-animal
sinitarg :animal)
(question :initformnil :accessor node-question
sinitarg :question)
(yes-node :initformnil :accessor node-yes-node
sinitarg :yes-node)
(no-node :initformnil :accessor node-no-node

cinitarg :no-node)))

(def-kb-class root ()
((node :initformnil :accessor root-node
sinitarg :node)))

(def -Kkb-struct current-node node)
(def -kb-struct gane-over node ani mal answer)

S R FORWARD CHAI NI NG RULES -------------

77, if there is no question we are about to ask then
;;; ask the question which is the root question of the
;;, question tree

(defrule play :forward
(root ?r node ?node)
(not (current-node ? node ?))
-->
((tk: send- a- ressage
(format nil " AN MAL GUESSI NG GAME - ~
think of an aninmal to continue")))
(assert (current-node ? node ?node)))
;;; ask a yes/no question - these are non-|eaf questions

(defrule y-n-question :forward

(current-node ?current node ?node)

(node ?node animal nil question ?q yes-node ?y-n
no- node ?n-n)

-->

((tk:confirmyes-or-no ?q) ?answer)

(erase ?current)

((find-new node ?answer ?y-n ?n-n) ?new current)

(assert (current-node ? node ?newcurrent)))

(defun find-new node (answer yes-node no-node)
(i f answer yes-node no-node))
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ask an ani mal question - these a | eaf questions

(defrul e ani mal - question :forward
(current-node ?current node ?node)
(node ?node ani nal ?ani mal question nil)
-->
((tk:confirmyes-or-no
(format nil "Is it a ~a?" ?aninmal)) ?answer)
(erase ?current)
(assert (game-over ? node ?node ani mal ?ani na
answer ?answer)))

add new nodes to the tree for the new ani nal and
the question that distinguishes it

(defrul e new question :forward

cpriority 20
(gane-over ? node ?node ani mal ?ani mal answer nil)
-->

(fetch-new ani mal ?new ani nal)
((tk: popup-pronpt-for-string
(format nil "Tell me a question for which the ~

answer is yes for a ~a and no for a ~a"
?new ani mal ?ani mal)) ?question)

(assert (node ?yes-node question ni
ani mal ?new ani mal ))

(assert (node ?no-node question nil animal ?aninal))

(assert (node ?node animal nil yes-node ?yes-node
no- node ?no-node question ?question)))

gane is over

(defrul e game-finished :forward
cpriority 15
(gane-over ?g)
-->
(erase ?g)
(test (not (tk:confirmyes-or-no "Play again?")))
(return))

--------------- BACKWARD CHAI NI NG ----------------
pronpt user for new ani ma

(defrul e fetch-new ani nal : backward
((fetch-new ani mal ?new ani nal )
<- -
(repeat)
((string-upcase
(tk: popup-pronpt-for-string
"What was your ani nmal ?"))
?new ani mal )
(not (= ?newanimal "NIL"))
check if abort was pressed
(or
(does- not - exi st-al ready ?new ani mal)
(and ((tk:send-a-nessage "Ani nmal exists already"))

(fail)))))

check if a node already refers to this aninal

(defrul e does-not-exist-al ready : backward
((does-not - exi st -al ready ?ani mal)
<= -
(node ? aninmal ?animal)
(cut)
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(fail))

((does-not - exi st-al ready ?ani mal)

<-))
--------------- SAVI NG THE ANI MAL BASE - ----------

writes out code which when | oaded reconstructs the
tree of questions

(defun save-aninmals (fil enane)
(let* ((start-node (any "~ ?node " (root ? node ?node)))
(code " (make-instance "root
:node , (node-code start-node)))
(*print-pretty* t))
(with-open-file
(streamfil ename :direction :output
;i f-exists :supersede)
(wite " (in-package kw user) :stream strean)
(wite-char #\Newl i ne stream
(wite code :stream strean))

nil))

(defun node-code (node)
(when node
" (make-i nstance " node
:question , (node-question node)
;animal ", (node-ani mal node)
:yes-node , (node-code (node-yes-node node))
: no- node , (node-code (node-no-node node)))))

B.2 Explanation Facility

Below is the complete code implementing the simple explanation facility of 6.1.1.3 A Simple Explanation Facility. The
implementation principle is exactly as described.

L A SI MPLE EXPLANATION FACILITY ---------
(i n-package kw- user)

; connects rule to explanation definitions
(defvar *expl anati on-tabl e*
(make- hash-table :test # eq))

; explanation generated at run tine
(defvar *expl anation* nil)

;55 the next four definitions make up the defexplain
;;: macro for each of the why, what and because

;;; definitions we create a function which we can cal
;. at run time on the bindings of the instantiation to
;;: generate the explanation text - this will be

;;, reasonably efficient

(defun is-var (expr)
"is this a variable (i.e. starts with ?)"

(and (symnbol p expr)
(eql (char (synbol-nane expr) 0) #\?)))

(defun find-vars (expr)
"returns a list of all the variables in expr”
(if (consp expr)
(append (find-vars (car expr))
(find-vars (cdr expr)))
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(if (is-var expr) (list expr) nil)))

(defun make-expl ai n-func (explain-stuff)
"generates a function to generate explanation text at
run tine"
(let* ((explain-string (car explain-stuff))
(explain-args (cdr explain-stuff))
(vars (renove-duplicates
(find-vars explain-args))))
“#' (1 anbda (bi ndi ngs)
(let ,(mapcar
#' (1l arbda (v)
“(,v (cdr (assoc ",v bindings))))
vars)
(format nil ,explain-string
, @xplain-args)))))

(defmacro defexplain (rul enane & ey why what because)
"puts an entry for the rule in the explanation table"
“(setf (gethash *,rul enane *expl anati on-tabl e*)

(list ,(make-expl ai n-func why)
, (make- expl ai n-func what)
, (make- expl ai n-func because))))

next two definitions generate an expl anation for
each instantiation that fires and stores it away in
*expl anati on*

(defun add-expl anation (inst)

"generate an explanation for firing this

instantiation"
(let ((explain-info

(get hash (inst-rul enane inst)
*expl anati on-tabl e*)))
(when explain-info
(do-the-rest explain-info (inst-bindings inst)))))

(defun do-the-rest (explain-info bindings)
"creates explanation text derived fromexplain
functions and bi ndi ngs"
(let ((why-func (first explain-info))
(what -func (second expl ain-info))
(because-func (third explain-info)))
(push " (,*cycle* ,(inst-rul enane inst)
, (funcal |l why-func bindi ngs)
, (funcall what-func bindi ngs)
, (funcal |l because-func bindings))
*expl anation*)))))

nmeta-interpreter for explanation contexts
before firing the rule generate explanation for
this cycle

(defrul e expl ai n-context :backward

((expl ai n-cont ext)

<- -

(start-cycle)

(instantiation ?inst)
((add- expl anati on ?inst))
(fire-rule ?inst)

(cut)

(expl ai n-context)))

sinple text output of the explanation

(defun explain (&optional cycle)
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"print out either the whole explanation or just for
one cycl e"
(if cycle (explain-cycle (assoc cycle *explanation*))
(dolist (cycle-entry (reverse *expl anation*))
(expl ain-cycle cycle-entry))))

(defun explain-cycle (entry)
"print this explanation entry"
(if entry
(let ((cycle (first entry))
(rul enane (second entry))
(why (third entry))
(what (fourth entry))
(because (fifth entry)))
(format t "~2%a: ~a~%-a~%-a~%-a"
cycl e rul enane why what because))
(format t "~2%No explanation for this cycle")))

we could make a really smart tool here, but to give
the general idea...

(defun expl ai n-an-action ()
(let ((item
(tk:scrollabl e-nenu
(reverse *expl anati on*)
:title "Wiich action do you want
expl ai ned?"
:nane-function # (lanmbda (x) (fourth x)))))
(if item(tk:send-a-nessage (fifth item))))

starting the rule interpreter should clear any old
expl anati on

(defadvice (infer rest-explanation :before)
(& est args)
(unless *in-interpreter* (setq *explanation* nil)))

Below are some example rules using the explanation facility. They are taken from the Monkey and Banana Example
distributed with KnowledgeWorks. The classes used in the example are nonkey, obj ect and goal .

(defrule nb7 :forward
:context mab
(goal ?g status active type hol ds object ?w)
(object ?0l1 kb-nane ?w at ?p on floor)
(rmonkey ?mat ?p holds nil)
-->
((format t "~%Grab ~s" ?w))
(assert (nonkey ?m holds ?w))
(assert (goal ?g status satisfied)))

(def expl ain mb7
:why ("Mnkey is at the ~s which is on the floor" ?w)
:what ("Monkey grabs the ~s" ?w)
:because ("Mnkey needs the ~s sonewhere el se" ?w))

(defrule nbl2 :forward
:context mab
:context mab
(goal ?g status active type wal k-to object ?p)
(monkey ?mon floor at ?c holds nil)
(test (not (eq ?c ?p)))
-->
((format t "~9Malk to ~s" ?p))
(assert (nobnkey ?mat ?p))
(assert (goal ?g status satisfied)))
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(def expl ain nbl2
:why ("Monkey is on the floor holding nothing")
:what ("Monkey wal ks to ~s" ?p)
: because ("Mnkey needs to do sonething with an
obj ect at ~s" ?p))

(defrule nbl3 :forward
:context mab
(goal ?g status active type wal k-to object ?p)
(monkey ?mon floor at ?c holds ?w)
(test (and ?w (not (eq ?c ?p))))
(obj ect ?0l kb-nane ?w)
-->
((format t "~9%Malk to ~s" ?p))
(assert (nonkey ?mat ?p))
(assert (object ?0l at ?p))
(assert (goal ?g status satisfied)))

(defexplain nmbl3
:why ("Mnkey is on the floor and is holding the ~s"
W)
:what ("Monkey walks to ~s with the ~s" ?p ?w)
:because ("Mnkey wants the ~s to be at ~s" ?w ?p))

(defrule nbl4 :forward
:context mab
(goal ?g status active type on object floor)
(rmonkey ?m on ?x)
(test (not (eq ?x “floor)))
-->
((format t "~%unmp onto the floor"))
(assert (nonkey ?mon floor))
(assert (goal ?g status satisfied)))

(defexpl ain nmbl4
:why ("Mnkey is on ~s" ?x)
:what ("Monkey junps onto the floor")
: because ("Mnkey needs to go sonewhere"))

(defrule nbl7 :forward
:context mab
(goal ?g status active type on object ?0)
(obj ect ?0l kb-nane ?0 at ?p)
(monkey ?mat ?p holds nil)
-->
((format t "~ inb onto ~s" ?0))
(assert (nonkey ?m on ?0))
(assert (goal ?g status satisfied)))

(defexpl ain nmbl7
:why ("Monkey is at the |ocation of the ~s" ?0)
:what ("Monkey clinbs onto the ~s" ?0)
: because ("Mnkey wants to be on top of the ~s" ?0))

(defrule nbl8 :forward
:context mab
(goal ?g status active type holds object nil)
(rmonkey ?m hol ds ?x)
(test ?x)
-->
((format t "~%rop ~s" ?x))
(assert (nonkey ?m holds nil))
(assert (goal ?g status satisfied)))

(defexplain nmbl8

133



Appendix B: Examples

:why ("Mnkey is holding the ~s" ?x)

:what ("Monkey drops the ~s" ?x)

:because ("Mnkey wants to do sonething for which he
can't hold anything"))

B.3 Uncertain Reasoning Facility

Below is the complete code which implements the uncertain reasoning facility of 6.1.1.4 Reasoning with Certainty Factors.
The implementation is exactly as described with afew extra considerations to check the rule interpreter is running before
returning an uncertain value, that the objects have a certainty-factor slot and so on.

e S| MPLE REASONI NG W TH UNCERTAI NTY FACTCRS - - - -
(i n-package kw- user)

7, default certainty factor
(defvar *c-factor* 1)

;;, inmplication strength of a rule
(defvar *inplication-strength* 1)

(defun default-c-factor ()
"if the forward chainer is not running, certainty
factor is just 1"
(if *in-interpreter*
(* *inplication-strength* *c-factor*)

1)

;;. uncertain objects need a slot to store their
;;; ~probability' this slot defaults to the val ue
;;: returned by default-c-factor

(def -kb-cl ass uncertai n-kb-obj ect ()
((c-factor :initform (default-c-factor)
sinitarg :c-factor)))

(defun object-c-factor (obj)
"if an object has no uncertainty slot, return 1 (i.e.
certain)”
(if (slot-exists-p obj “c-factor)
(sl ot-value obj “c-factor)

1)

(defun inst-c-factor (inst)
"the certainty factor of an instantiation"
(token-c-factor (inst-token inst)))

(defun token-c-factor (token)
"the certainty factor of an ANDed |ist of objects
(just multiply them"
(reduce "* (mapcar "object-c-factor token)))

(defun inplication-strength (val)
"for a rule to set the inplication strength"
(setqg *inplication-strength* val))

;55 this function increases the certainty of the object
77, Which is the first argument by an anmpunt dependent
;55 on the conbined certainty of the renaining

;. arguments

(defun add-evi dence (obj &rest token)
"increments the certainty of obj based on the
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certainty of token"
(let ((c-f (slot-value obj “c-factor)))
(setf (slot-value obj “c-factor)
(+ c-f
(* (- 1 c-f) *inplication-strength*
(token-c-factor token))))))

this tactic is dynanic as the certainty factor slot
gets changed by cal li ng add-evi dence

(deftactic certainty :dynamc (il i?2)
"a conflict resolution tactic to prefer nore certain
i nstantiations"
(> (inst-c-factor i1) (inst-c-factor i2)))

Before firing a rule this meta-interpreter just
sets the value of *c-factor* to the certainty of
the instantiation so that any new uncertai n objects
made get this (tines *inplication-strength*) as
their certainty. Al so sets *inplication-strength*
to 1 as a default in case the rule does not set it.

(defrul e uncertai n-context :backward

((uncertai n-cont ext)

<= -

(start-cycle)

(instantiation ?inst)

((progn (setq *c-factor* (inst-c-factor ?inst))

(setqg *inplication-strength* 1)))

(fire-rule ?inst)

(cut)

(uncertain-context)))

Below are some example rules using this facility for a simple car maintenance problem.

---------------- SOVE EXAMPLE RULES ---------------
to run: (run-di agnose)

(def-kb-struct start)

(def-kb-cl ass synptom (uncertai n-kb-obj ect)
((type :initarg :type)))

(def-kb-class fault (uncertain-kb-object)
((type :initarg :type)))

(def -kb-cl ass renmedy (uncertai n-kb-object)

((type :initarg :type)))

this context sets up the initial hypotheses and
gat hers evidence this does not need the neta
-interpreter as that's only necessary for
transparent assignnent of certainty factors to new
obj ects

(defcontext diagnose :strategy ())

(defrule start-rule :forward
:context di agnhose
(start ?s)
-->
(assert (synptom ? type over-heat c-factor 1))
(assert (synptom ? type power-loss c-factor 1))
(assert (fault ? type lack-of-o0il c-factor 0.5))
(assert (fault ? type lack-of-water c-factor 0))
(assert (fault ? type battery c-factor 0))
(assert (fault ? type unknown c-factor 0))
(context (cure)))
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next context onto agenda

(defrul e di agnosel :forward
:context di agnhose
(synptom ?s type over-heat)
(fault ?f type |ack-of-water)
-->
((inplication-strength 0.9))
((add-evi dence ?f ?s)))

(defrul e di agnose2 :forward
:context di agnose
(synptom ?s type overheat)
(fault ?f type unknown)

-->
((inplication-strength 0.1))
((add-evi dence ?f ?s)))

(defrul e di agnose3 : forward
:context di agnhose
(synptom ?s type wont-start)
(fault ?f type battery)

-->
((inplication-strength 0.9))
((add-evi dence ?f ?s)))

(defrul e di agnose4 :forward
:context di aghose
(synptom ?s type wont-start)
(fault ?f type unknown)

-->
((inplication-strength 0.1))
((add-evi dence ?f ?s)))

(defrul e di agnose5 : forward
:context di aghose
(synptom ?s type power-| oss)
(fault ?f type lack-of-o0il)
-->
((inplication-strength 0.9))
((add-evi dence ?f ?s)))

(defrul e di agnose6 :forward
:context di aghose
(synptom ?s type power-| oss)
(fault ?f type unknown)

-->
((inplication-strength 0.1))
((add-evi dence ?f ?s)))

any two distinct synptons strengthens the
hypot hesis that there's sonething nore serious
goi ng wrong

(defrul e di agnose7 :forward
:context di aghose
(synptom ?sl1 type ?t1l)
(synptom ?s2 type ?t2)

(test (not (eq ?tl ?t2)))
(fault ?f type unknown)

-->

((add-evidence ?f ?sl ?s2)))

here we need the neta-interpreter to assign the

right certainty factors to the renedy objects. Al so
use certainty as a conflict resolution tactic to
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print the suggested renedi es out in order

(defcontext cure :strategy (priority certainty)
:meta ((uncertain-context)))

(defrule curel :forward
:context cure
(fault ?f type unknown)
-->
((inplication-strength 0.1))
(assert (remedy ? type cross-fingers))
((inplication-strength 0.9))
(assert (remedy ? type go-to-garage)))

(defrule cure2 :forward
:context cure
(fault ?f type lack-of-o0il)
-->
(assert (remedy ? type add-oil)))

(defrule cure3 :forward
:context cure
(fault ?f type |ack-of-water)
-->
(assert (renmedy ? type add-water)))

(defrule cured4 :forward
:context cure
(fault ?f type battery)
-->
(assert (renmedy ? type new battery)))

(defrule print-cures :forward
:context cure

ipriority 5
(renmedy ?r type ?t)
-->

((format t "~%Buggest renedy ~a with certainty-factor
~a" ?t (slot-value ?r “c-factor))))

(defun run-di agnose ()
(reset)

(make-instance “start)
(infer :contexts " (diagnose)))

B.4 Other Examples

Other examples distributed with KnowledgeWorks include:
» Truck — alargely forward chaining truck scheduling example.
» Spill — an outline of achemical spillage diagnosis system.

» Whist — awindowing example which plays whist.
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C.1 Forward Chainer

C.1.1 Forward Chaining Algorithm

The KnowledgeWorks forward chaining engine is based on the RETE agorithm (see Rete: A Fast Algorithm for the Many
Pattern/Many Object Pattern Match Problem by Forgy in Artificial Intelligence 19, September 1982). A dataflow
network representing the conditions of the forward chaining rules (a RETE network) is maintained and this keeps lists of the
instantiations and partia instantiations of rules. This structure is modified at run time as objects change. The RETE
algorithm relies on the tacit assumption that during the forward chaining cycle relatively few objects change (hence there are
relatively few changes to be made to the network each cycle), and in these cases gives a huge increase in performance speed.

C.1.2 CLOS and the Forward Chainer

CLOS abjects acquire KnowledgeWorks functionality from the st andar d- kb- obj ect mixin. Object creation and
modification hooks defined on this mixin enable the RETE network to track the objects. Objects are indexed into the RETE
network by class and modifications propagated only where any changes to the slots of the object are relevant.

One potential problem isthat as KnowledgeWorks CLOS objects are designed for use in ordinary code, performance could
deteriorate seriously as every time an object is changed the RETE network must be amended. For this reason changesto
CLOS objects are merely remembered as they are made. The stored set of changesis flushed at the start of every forward
chaining cycle, so the penalty for using KnowledgeWorks objectsis really only paid when the forward chainer is running.

C.1.3 Forward Chaining and the Backward Chainer

For more uniform semantics throughout K nowledgeWorks, the right hand side of KnowledgeWorks forward chaining rules
are executed directly by the backward chainer, asis the default meta-interpreter for a context which has no meta-interpreter
specially defined. When compiled with debugging turned off, in many cases the backward chainer can be optimized out
leaving raw Lisp code.

C.2 Backward Chainer

C.2.1 Backward Chaining Algorithm

The KnowledgeWorks backward chaining system is an extended Prolog written entirely in Lisp and based loosely on the
Warren Abstract Machine (WAM). (see An Abstract Prolog I nstruction Set by David H.D. Warren, Technical Note 309
SRI International October 1983). High performance is achieved by compiling each Prolog clause into a Lisp function and
handling the Prolog control flow with continuation passing. This approach removes the need for interpretation and provides
easy integration with CLOS.
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C.2.2 Term Structure

In order to provide compatibility with Edinburgh Prolog, the KnowledgeWorks backward chaining system treats Prolog
structured terms differently from lists. Structured terms whose functors are not "." are stored as simple vectors with the
functor as element 0 (for example, theterm: f oo( bar) isequivaentto#(f oo bar)).

C.2.3 The Binding Trail

The variable binding trail for the backward chainer is stored in a simple vector but may overflow into list structure if the trail
grows larger than the size of the vector: (30000). The system will continue to function normally when this happens but may
slow down dlightly and do more consing. (Note: We have never written a program that causes this to happen other than
deliberately produced testing programs).
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D.1 General References

D.1.1 Forward Chaining

» Programming Expert Systemsin OPS5, An Introduction to Rule-Based Programming by Lee Brownston, Robert Farrell,
Elaine Kant and Nancy Martin (Addison-Wesley). While being specifically on OPS5, this text covers most aspects of
forward chaining in considerable detail.

D.1.2 Backward Chaining and Prolog
» The Art of Prolog, by Leon Sterling and Ehud Shapiro (MIT Press).

» The Craft of Prolog, by Richard A. O'Keefe (MIT Press). Thisisamore advanced text.

D.1.3 Uncertain Reasoning

* Rule-Based Expert Systems, by B. G. Buchanan and E. H. Shortliffe (Addison-Wesley). Thistext covers specificaly the
MY CIN system.

D.1.4 Expert Systems

* Building Expert Systems, by Frederick Hayes-Roth, Donald A. Waterman and Douglas B. Lenat (Addison-Wesley).
This text focuses more on the issuesinvolved in designing an expert system.

D.1.5 Lisp and CLOS
e Common LISPcraft, by Robert Wilensky (Norton). Anintroductory text on Lisp.

» Common Lisp the Language, Second Edition, by Guy. L. Steele Jr. (Digital Press). Thisisthe complete reference book
on Common Lisp.

» Object-Oriented Programming in Common Lisp, by Sonya E. Keene (Addison-Wesley). Anintroductory text on CLOS
for programmers.

» The Art of the Metaobject Protocol, by Gregor Kiczales, Jim des Rivieres and Daniel G. Bobrow (MIT Press). Thisis
the only proper guide to the CLOS Metaobject Protocol.

D.2 The LispWorks manuals

In addition to the KnowledgeWorks and Prolog User Guide, the LispWorks manual set includes the following manuals which
might be helpful while using KnowledgeWorks:

» The LispWorks® User Guide and Reference Manual describes the language-level features and tools available in
LispWorks, along with detailed information on the functions, macros, variables and classes.
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» The LispWorks IDE User Guide describes the LispWorks IDE, the user interface for LispWorks. the LispWorks IDE isa
set of windowing tools that let you develop and test Common Lisp code more easily and quickly.

» The Editor User Guide describes the keyboard commands and programming interface to the the LispWorks IDE editor
tool.

» The Release Notes and Installation Guide explains how to install LispWorks, configure it and start it running. It also
contains a set of release notes that documents last minute issues that could not be included in the main manual set.

These books are all availablein HTML and PDF formats.

Commands in the Help menu of any of the the LispWorks IDE tools give you direct access to the online documentation in
HTML format. Details of how to use these commands can be found in the LispWorks IDE User Guide.

Pleaselet usknow at | i sp- support @i spwor ks. comif you find any mistakesin the LispWorks documentation, or if you
have any suggestions for improvements.
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E.1 OPS5

OPS5 rulebases may be readily converted into KnowledgeWorks rulebases. The main OPS5 forms needing conversion are:

e literalizeintodef-kb-struct ordef-kb-cl ass. For example:

(literalize enpl oyee nane father-nane nother-nane)
could become:

(def -kb-struct enpl oyee nane father-nane nother-nane)

* strat egy into adefcontext form with the right conflict resolution strategy. For example:
(strategy | ex)
could become:
(defcontext ops5 :strategy (lex specificity))
and:
(strategy nea)
could become:

(defcontext ops5 :strategy (nmea | ex specificity))

In OPS5 you cannot have different conflict resolution strategies for different sets of rules. The KnowledgeWorks context
mechanism for passing control is much clearer and more powerful than, for instance, the use of the MEA strategy as sole
control mechanism in OPS5.

* pintodefrul e. For example, the OPS5 rule:

(p recogni ze-pair
(enpl oyee “nane <parent>)
(enpl oyee "nane <chil d> ~not her-nane <parent>)
-->
(make pair))

will become:
(defrul e recogni ze-pair :forward
(enpl oyee ? nane ?parent)

(enpl oyee ? name ?child nother-nane ?parent)
-->

(assert (pair ?)))

As an extended example below are given some OPS5 rules from the Monkey and Banana problem (see Appendix B:
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Examples):

(strategy nea)
(literalize nmonkey

nane at on hol ds)
(literalize object

nane at wei ght on)
(literalize goa

status type object to)
(literalize start)

(p mbl
(goal ~"status active “type hol ds ”“object <w>)
(obj ect “name <w> "at <p> “on ceiling)

-->
(make goal ~status active ~type nove ”~object |adder
to <p>))
(p b4

{(goal ~"status active “type hol ds “object <w>) <goal >}
(obj ect “name <w> "at <p> “on ceiling)

(obj ect ~name | adder "“at <p>)

{(monkey ”~on | adder “~holds nil) <nobnkey>}

-->

(wite (crlif) Gab <w)

(nmodi fy <goal > ~status satisfied)

(rmodi fy <nonkey> “~hol ds <w>))

(p b8
(goal ~"status active “type nove “object <o> "to <p>)
(obj ect ~“name <o> “weight light ~at <> <p>)
-->
(rmake goal ~status active ~type holds "object <0>))

In KnowledgeWorks this could be:

(defcontext ops5 :strategy (nmea | ex specificity))

(def - named- kb-cl ass nonkey ()
((at :initformnil)
(on :initformnil)
(holds :initformnil)))

(def - named- kb-cl ass obj ect ()
((at :initformnil)
(weight :initformnil)
(on :initformnil)))

(def-kb-struct goal status type object to)
(def -kb-struct start)

(defrule nbl :forward
:context ops5
(goal ? status active type holds object ?w
(object ? name ?w at ?p on ceiling)
-->
(assert (goal ? status active type nove object |adder
to ?p)))

(defrule nb4 :forward
:context ops5
(goal ?g status active type holds object ?w)
(object ? name ?w at ?p on ceiling)
(object ? nane | adder at ?p)
(monkey ?mon | adder holds nil)
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-->

((format t "~%Grab ~S" ?w))
(assert (goal ?g status satisfied))
(assert (nonkey ?m holds ?w)))

(defrule nb8 :forward
:context ops5
(goal ? status active type nove object ?0 to ?p)
(object ? name ?0 weight light at ?q)
(test (not (eq ?q ?p)))

-->
(assert (goal ? status active type holds object ?0)))

E.2 Prolog

Please refer to A.10 Edinburgh Syntax.
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agenda

A stack of rule groups (or contexts). Control can be passed to the next context on the agenda.

arity

The number of arguments (to a function, rule condition etc.)

backward chaining
The process of reasoning backward from postulated goals to determine if their preconditions can be satisfied. If these
preconditions are satisfied the postulated goals are considered true.

browsers

Windows which allow you to look freely through different parts of the system.

class

In object-oriented programming, classes define classes with the same attributes (dots) and behavior (methods).
Instances of these classes are created during the execution of a program which represent concrete examples of the
abstract class descriptions.

conflict resolution strategy
The method(s) used to decide which of a set of eligible ruleswill fire. A conflict resolution strategy isalist of conflict
resol ution tactics which are applied in sequence to the conflict set to determine which instantiation is to fire.

conflict resolution tactic
A single predicate used to decide whether one instantiation is to be preferred to another. They may be combined into a
conflict resolution strategy.

conflict set

The set of instantiations of rules which at a given time are matched by the object base.

contexts

Groups of rulesin a knowledge base.

destructuring

The ability to match an expression against a piece of datawhere variablesin the expression are bound to the
corresponding parts of the data if the structure of the expression and the data agree. For example, (?x . ?y) can match
(1 2 3) with ?x binding to 1 and ?y to (2 3).

forward chaining

The process of reasoning forward from known facts to perform arbitrary actions and to deduce new facts.
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forward chaining cycle
The process of matching the conditions of rules against the object base to produce a set of rules eligible to fire (the
conflict set), selecting one of those (conflict resolution) and firing it (performing its actions).

inference engine

The part of the system which isresponsible for rule-firing, either in backward or forward chaining mode.

inferencing state

A collection of information that the inferencing engine uses.

instantiation
Aninstantiation of aruleisthe set of objects against which arule matches. A rule may have no instantiations (if it is
not matched at all by the object base) or many instantiations (each referring to a different set of objects).
knowledge based systems
A system which encodes the knowledge for a problem domain in high-level forms, usually facts and rules. The
software architecture separates the knowledge from the inference mechanism used to deduce new knowledge.
LispWorks

An advanced Common Lisp programming environment, which serves as the infrastructure for KnowledgeWorks.

meta object protocol (MOP)
Describes how the Common Lisp Object System isimplemented in terms of itself. Hence CLOS may be used to
modify its own behavior.

meta rule protocol (MRP)
Allows you to debug, modify or replace the default behavior of forward chaining rulesin the system in terms of
backward chaining goals.

object base

The set of CLOS objects which KnowledgeWorks can reason over ("knows about”).

object-oriented
Programming paradigm in which structures within the language are organized as classes of objects which have
attributes (slots) and behavior (methods) associated with them.

objects
The KnowledgeWorks® object base contains K nowledgeWorks CLOS objects, which may for efficiency be replaced by
K nowledgeWorks structures.

structures

A CLOS class can be replaced by a structure class in cases where speed isimportant and the code must be optimized,
and when the full power of CLOS is not required. The structure is then analogous to the CLOS object.
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toolkit

A collection of complementary software or utilities (such as K nowledgeWorks®) with a common application focus.
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